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Welcome to OSAS

The OPEN SYSTEMS Accounting Software (OSAS) product line consists of 
several accounting applications. Each application addresses a different phase of 
your financial operations; together, they form a powerful accounting solution to 
your daily and periodic accounting needs.

Customer Support   

Open Systems, Inc. has a strong commitment to customer service and product 
quality. If you have difficulty using Open Systems, Inc. products, consult your 
user’s manual and other OSAS reference materials. If you need more 
information, consult a customer support representative.

OSAS Overview

Resource Manager   

The Resource Manager application is the foundation or shell of OSAS. It 
provides the operating environment that holds the other applications. Resource 
Manager also includes three powerful business features: Global Inquiry, 
Executive Information Summary (EIS), and Print Manager. With Global Inquiry, 
you can drill through your accounting data to find selected information 
throughout your system. With EIS, you can access company information quickly 
and view summaries of all aspects of a company or a group of companies. With 
Print Manager, when you print reports to file, your reports can be stored, sorted, 
printed, and searched for specific text.

Base Applications   

Base applications are designed and produced with the largest possible number of 
industries in mind. They are most effective when you interface them with each 
other. Base applications are usually named after common accounting operations. 
Examples are: General Ledger, Accounts Payable, Purchase Order, Accounts 
Receivable, Sales Order, Payroll, and Inventory.
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Welcome to OSAS  Introduction
Running OSAS

OSAS runs on an operating system supported by 150 megabytes of permanent 
storage and 4MB of RAM. You may need additional space or memory, 
depending on the size of your data files and the operating system you use. 
Consult your reseller for more information. 

Starting OSAS in Windows

To start OSAS on a computer running Windows, double-click the OSAS shortcut 
on the desktop or access the program from the Start menu.

Starting OSAS on Other Operating Systems

To start OSAS on an operating system other than Windows, enter osas at the 
operating system prompt.

The osas command can recognize three parameters: -t, -c, and -a.

The terminal ID (-t) is the identification code assigned to the terminal you are 
using to run OSAS. On multiuser systems, each terminal usually has a default ID 
assigned when the terminals were added to the system. Use the -t parameter only 
when you want to log on with an ID other than the default ID. The terminal 
parameter is valid only if you are using Resource Manager for LANs.

The company ID (-c) is the identification code assigned to a company. If your 
system carries two or more companies and you do not enter a company ID, the 
menu of the company entered by the last person who used the terminal appears.

The access code (-a) is your personal password. Use the Access Codes function 
on the Resource Manager Company Setup menu to set up access codes.

The most general expression for getting into OSAS takes all the parameters into 
account. For example, if you are on terminal 2 (T2) working with company B, 
and the password is apple, specify that information to access the system:

osas -t T2 -c B -a apple
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Welcome to OSASIntroduction
In UNIX you can enter the parameters in any order, and you can use any 
combination. You must leave a space between the parameter mark (-t, -c, or -a) 
and the parameter itself.

Note

In Windows, you can set up OSAS such that it always opens using a certain 
access code. Open the OSAS program shortcut’s properties and enter the 
access code and your company ID in the Target box. For example, using 
apple as your access code and H as your company ID, enter the following: 

C:\osas\progRM\osastm.exe -m4096 -tT00 -nT00 - -aapple -cH

If you want the system to prompt for an access code after opening, enter -a in 
the Target field, followed by a space, followed by -c and the company ID.

In the Windows icon properties, the parameter marks (-m, -t, or -n) can be 
entered in any combination but must be before the separation dash. The 
access code and company ID commands (-a and -c) must be entered after the 
separation dash. See the Resource Manager Installation Manual for more 
information on these parameters.
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The ODBC Kit

Use the ODBC Kit to access your OSAS company information from any ODBC-
compliant application such as Microsoft Access, Excel, Query™, or Word™; 
Crystal Reports, and so forth. The functions available from the OSAS menu are 
used to manage the data dictionaries and the ODBC driver.

Menu Structure

The ODBC Kit menu structure is similar to the structure of other OSAS 
applications: functions appear roughly in order of use.

Edit CONFIG.TPM

Use the Edit CONFIG.TPM function to set up a database configuration file for 
each company installed in OSAS whose data you want to access using the ODBC 
drivers.

Dictionary Tools

Use the functions on the Dictionary Tools menu to set up and maintain 
information about your data dictionary. For example, use the Update Reserved 
Words function to establish and update information about reserved words for the 
version of SQL you use. 

Dictionary Reports

Use the Dictionary Reports functions to verify that field names are not SQL 
reserved words, to produce a list of field and file names in the data dictionary.

Application Interaction

The ODBC Kit is an application that translates your OSAS data into fields 
accessible through SQL (Structured Query Language). You can use SQL to 
access any application included in the data dictionary to which you have access 
rights.
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Conventions

This manual helps you install OSAS on any standard computer running any of 
several popular operating systems and helps with your accounting software 
questions. Use the manual as a reference for the OSAS interface and application 
functions.

Manual Conventions

This manual is divided into the following sections:

• This introduction provides an overview of this application and the OSAS 
system, the basic functionality of the application including graphical and 
text-based application features, and function key references.

• The remainder of the chapters explains the set up, workflow, and functions 
of the application: where each function fits within the application and how to 
use each function to get the most out of the application.

Mouse Conventions

The standard mouse has two buttons, left and right, each performing certain 
functions. In this manual, these terms are used for operating the mouse: click, 
right-click, double-click, and deselect.

The click is a single press on the left mouse button. Place the cursor over the 
desired function, and press the left button to enable, or select, that function. 

A right-click is a single press of the right mouse button.

To double-click, move the cursor over the desired function and quickly press the 
left mouse button twice. If there is too long a pause between clicks, the computer 
may interpret your action as two separate clicks and may not perform the desired 
function.
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Conventions  Introduction
To deselect an object, move the cursor off the icon or folder onto a blank space 
within the window and press the left mouse button.

Note

Some mouse manufacturers allow you to change the function of the mouse 
buttons for those who prefer (for example) to use the mouse with their left 
hand. In this case, reverse the commands when you use them. For example, a 
click refers to a single press of the right mouse button, while the term right-
click refers to a single press of the left button.

GUI/Text Command Conventions

When you see the phrase “use the Proceed (OK) command” in the user’s 
manuals, press PgDn in either text or graphical mode. In graphical mode, 
clicking OK has the same effect as pressing PgDn.

GUI/Text Menu and Function Conventions

When you start OSAS, the main menu appears and lists the applications available 
for use. If you are using UNIX or Linux, the text main menu appears. 

If you are using Windows, you can choose between the text main menu, the 
graphical main menu, or the start-style main menu. Use the Defaults function 
under the Resource Manager Workstation Configuration menu to select the 
style of menu you want to appear by default, or you can press Shift+F5 to toggle 
between the menu styles from any menu. You can use any of the menus 
regardless of whether you use the text or graphical modes for the OSAS 
functions.

In addition, if you are using Windows, you can use either text or graphical 
function screens independently of the main menu. For example, you can use text 
function screens even if you are using the graphical main menu and vice versa. 
Select GUI Functions from the Modes menu or press Shift+F6 to toggle between 
the text and graphical modes for function screens.
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ConventionsIntroduction
Access Codes

Your company can limit use of the system by defining access codes and assigning 
them to employees. Each code allows access to specific applications, menus, and 
functions. If you cannot select a menu, your access code is not authorized for it. 

Use the Access Codes function on the Resource Manager Company Setup 
menu to set up access codes.

If you have more than one access code, select Access code from the File menu 
or press F4. The Access Code box appears (the example below uses the graphical 
mode).

Enter the access code you want to change to, then click OK or press Enter.

Workstation Dates

To change the workstation date, select Workstation date from the File menu or 
press F6. The Workstation Date box appears (the example below uses the 
graphical mode).

Use the buttons or your keyboard to enter the date and click OK or press Enter to 
change the workstation date. Click System Date to change the workstation date 
to match the operating system date, click Abandon to restore the original date, or 
click Exit or press F7 to close the box without changing the date.
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OSAS Text Menu

The text main menu can be used on all operating systems. Using text-based 
menus, the text menu (shown below) offers easy access to your applications.

When you select an application, the application’s menu, which presents several 
related functions, is superimposed over the main menu. Selecting a function leads 
you to a function screen or to another menu. 

You can select applications from the main menu in these ways:

• Use the arrow keys to move the cursor up or down, highlighting the 
application you want to use. Then press PgDn or Enter to select it.

• Press the first letter of the application you want to use. The cursor jumps to 
the first application beginning with the letter. Continue to press the letter key 
or the down arrow until the application you want is highlighted. When your 
choice is highlighted, press PgDn or Enter to select it.
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OSAS Text Menu  Introduction
• Position the mouse cursor over the application and click. The application 
briefly highlights and switches to the application screen.

• To jump to the first application on the menu, press Home. To jump to the last 
application on the menu, press End.

To select a function from an application menu, highlight and select your choices 
the same way you do on the main menu—with one exception: you can press 
PgDn only when an option leads to another menu. You must press Enter to select 
a function.

On an application menu, you can press PgUp to move to the menu immediately 
above it. If you are several menu levels away from the main menu, you can return 
to the main menu by pressing PgUp repeatedly or by pressing the Tab key.

You can exit from a menu in these ways:

• Press PgUp to go to the previous menu (one menu up).
• Press the Tab key to go to the main menu.
• Use Exit (F7) to go to the operating system.

Commands

Several commands are available within the menu to perform various tasks such 
as changing the system date, entering access codes, switching between sample 
data and live data, and so on. To access a command, press the corresponding key. 
If you’re working with a keyboard that lacks function keys (labeled with an F 
followed by a number) or if you’re working with an emulator in UNIX (which 
can cause function keys to become unavailable), press the appropriate alternate 
key combination to access the command.

Command 
Key

Alternate 
Key

Description

Esc Opens a menu listing available commands. 
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OSAS Text MenuIntroduction
F1 (Help) Esc+H Opens the help description for the selected 
application/function. You must be within an 
application menu to access this command.

F2 
(Favorites)

Esc+W Toggles between the Favorites and main menus.

F3 (Change 
Company)

Esc+D Allows you to switch to a different company.

F4 (Access 
Code/Other)

Esc+O Allows you to enter an access code.

Pressing this key (or key combination) twice 
opens a utility menu similar to the Other 
Commands menu on graphical screens. See 
“Other Commands Menu” on page 1-22 for more 
information on the commands available.

F5 (Live/ 
Sample 
Data)

Esc+X Switches between live and sample data.

F6 
(Workstation 
Date)

Esc+F Allows you to change the workstation date.

F7 (Exit) Esc+M Exits from OSAS.

F8 (Print 
Screen)

Esc+L Allows you to output the current screen to a 
printer, print preview window, or file. 

F9 (Change 
Year)

Esc+U Allows you to change to a different fiscal year 
when you are inside the General Ledger or 
Payroll menus.

Command 
Key

Alternate 
Key

Description
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OSAS Text Menu  Introduction
F10 (Add to/
Delete 
Favorites)

Ctrl+Z Pressing this key (or key combination) on the 
main menu adds the selected application or 
function to your Favorites menu. Pressing this 
key on the Favorites menu removes the selected 
application or function from the Favorites menu.

Shift+F2 
(Application 
Info)

Esc+I Opens a screen listing information about the 
applications you have installed.

Shift+F5 
(Menu 
Style)

Esc+G On Windows workstations, pressing this key 
combination toggles between graphical and text 
main menus.

Shift+F6 
(Toggle GUI 
screens)

Esc+K On Windows workstations, pressing this key 
combination toggles between graphical and text 
function screens.

PgUp Moves back one menu level.

Tab Moves back to the main menu from any 
application menus.

Enter Selects an application menu or function from a 
menu.

Up/Down 
arrow

Moves the cursor up or down through the menu 
selections.

Command 
Key

Alternate 
Key

Description
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OSAS Graphical Menu

In a Windows environment, you can choose from two types of graphical-style 
menus. The standard graphical menu features application selections that 
resemble many Windows functions. The start-style menu is named so because of 
its functional resemblance to the Start menu in Windows 95, 98, NT, and 2000. 

Both graphical menus provide pull-down menus, convenient tool buttons, and 
easy access to your installed applications and their functions using either the 
mouse or keyboard. The two graphical menus provide you with a visual choice in 
your interaction with OSAS and your data.

When you select an application in either graphical OSAS menu, the application’s 
main menu, presenting several related functions, appears beside the OSAS menu. 
Selecting a function leads you to either a function screen or another menu.

Several commands are available within the menu to perform various tasks such 
as changing the system date, entering access codes, switching between sample 
data and live data, and so on. You can access commands in these ways (if a 
button or pull-down menu selection is muted or gray, it is not available for use):

• Click the appropriate graphical tool button.
• Select the command from a pull-down menu.
• Press the associated keyboard hot key.

If you use the graphical menu, you can select application menus and functions by 
clicking the function or menu name on the menu or by highlighting your choice 
and pressing Enter. If you choose the start-style menu, you can select 
applications from the main menu by using the arrow keys to highlight your 
choice and pressing Enter, by clicking the selection, or by holding the mouse 
cursor over the selection until the menu appears.

From any application menu, you can select a button from the previous menu to 
move directly to that menu. If you are several menu levels away from the main 
menu, you can return to the main menu by clicking items on the previous menus.
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OSAS Graphical Menu  Introduction
Graphical Main Menu

You can exit from a graphical menu in these ways:

• Select a button from a previous menu.
• Press the Tab key to go to the OSAS menu.
• Click the Close box in the upper-right corner of the window.
• Use Exit (F7).
• Select Exit from the File menu.
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OSAS Graphical MenuIntroduction
Start-Style Main Menu

You can exit from a menu in these ways:

• Press the left arrow key to go to the previous menu (one menu up).
• Hold the mouse over a different menu choice.
• Press the Tab key to go to the OSAS menu.
• Click the Close box in the upper-right corner of the window to close OSAS.
• Use Exit (F7) to close OSAS.
• Select Exit from the File menu to close OSAS.
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OSAS Graphical Menu  Introduction
Main Menu Elements

Pull-Down Menus

When using the graphical menus, you can use the pull-down menus and toolbar 
buttons to access functions without using the function keys. While the function 
keys work in graphical menus, the menu bar and toolbar buttons give you a 
choice in accessing these functions. The OSAS pull-down menu bar is shown 
below.

To access the menu’s commands, click one of the menu titles. The menu for that 
heading appears and lists available commands followed by any hot key 
combinations in brackets <>. To use a command, either click the command name 
or press the hot key(s) listed.

File Menu     

Command Description

Access Code Opens the Access Code dialog box. See “Access 
Codes” on page 1-11 for more information.

Sample data set/Live 
data set

Toggles between Sample and Live data.

Workstation date Opens the Workstation Date dialog box. See 
“Workstation Dates” on page 1-11 for more 
information.

Exit Exits OSAS.
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OSAS Graphical MenuIntroduction
Modes Menu       

Tools Menu       

Favorites Menu       

Command Description

GUI Functions Toggles between graphical and text function screens.

Scale GUI Screens Toggles scaling of graphical screens on and off. 
When selected, this command enlarges graphical 
screens. When off, the command restores the OSAS 
screens to their original size. This command does not 
take effect until you access a function.

Command Description

Calculator Opens the OSAS calculator.

Command Description

Change to Favorites Toggles between the Favorites and main menus. See 
“Favorites Menu” on page 1-49 for more information.
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OSAS Graphical Menu  Introduction
Other Commands Menu   

Command Description

Calculator Opens the OSAS calculator.

Execute an Operating 
System Command

Allows you to enter an operating system command 
from within OSAS.

Call a PRO/5 Program Allows you to execute a PRO/5 program.

Product Suggestions Creates a report for future OSAS product 
suggestions.

Application Options 
Inquiry

Allows you to view the application options you have 
set up for a particular application.

Global Inquiry Allows you to search across your data. You can 
select from the installed applications which data to 
search.

General Information 
Inquiry

Allows you to search for information on employees, 
customers, and vendors.

Support Information Displays the OSAS Support Information.

User Comments Allows you to record comments for your own use.

EIS Dashboard Display Displays the EIS Dashboard.

EIS Dashboard History Displays the EIS Dashboard history.
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OSAS Graphical MenuIntroduction
Help Menu       

Main Menu Toolbar

The main menu toolbar gives you quick access to frequently-used OSAS 
commands. To access a command, click the appropriate button.      

Pop-Up Calendar Allows you to create and read date reminders in 
OSAS.

Inventory Price 
Calculator

Allows you to calculate prices and view quantity, 
cost, and pricing information for inventory items.

Command Description

Help Opens help descriptions for the application menus 
and functions.

About OSAS Opens the About OSAS dialog box.

Command Description

Button Description

Opens the Workstation Date dialog box to change the date. 
See “Workstation Dates” on page 1-11 for more information.

Opens the Access Code dialog box to switch between access 
codes. See “Access Codes” on page 1-11 for information.

Displays the Application Information dialog box.
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Right-Click Menu    

On the graphical and start-style main menus, the right-click menu gives you 
quick access to commands that help you manage commands on your Favorites 
menu, switch between sample and live data, perform certain setup tasks, and 
view function information. To access the menu, click the right mouse button 
anywhere on the graphical or start-style main menu.

Opens help descriptions for the application menus and 
functions.

Opens the OSAS calculator.

Displays the pop-up calendar screen. You can use the 
calendar to add and review reminders for any date.

Opens an MS-DOS command window.

Displays a screen for calling any BBx program that does not 
require variables to be passed to it. For more information, see 
“Appendix F” in the Resource Manager User’s Manual.

Toggles between the Favorites and main menus. See 
“Favorites Menu” on page 1-49 for more information.

Button Description
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Data Set

On the start-style main menu, you can select the Live Data radio button to work 
with live data or select the Sample Data radio button to work with sample data. 
You can also press F5 to toggle between sample and live data.

Change Company Field

On the start-style or graphical main menu, select the company to change to from 
the list box.

Command Description

Add to/Remove 
Favorites (F10)

Use the Add to/Remove Favorites Menu button to 
add the desired submenu or function to or from your 
Favorites menu.

Change to Favorites/
Main
(F2)

Toggles your display menu between the Favorites 
and main menus.

Sample Data/Live 
Data (F5)

Switches between sample and live data.

Setup (F9) Performs certain application setup tasks. For 
example, in General Ledger, you can select the year 
with which you want to work. If Setup is required in 
an application, the application’s user’s manual 
describes its use.

Function 
Information (F1)

Displays information about the selected function.
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OSAS Text Functions

Like the text menu, OSAS text function screens can be used on all operating 
systems. On Windows workstations, text function screens can also be used with 
graphical menus (or vice versa—the text menu can be used with graphical 
function screens). 

Function screens provide you an interface to the data in your data files, allowing 
you to view, update, and change information as needed. Function screens also 
allow you to print reports or perform tasks on your data, such as calculations, 
purges, or the resetting of accumulated totals.

You can move around the screen in these ways:

• Press the down arrow or Enter to move from field to field.

• Select the appropriate command on the command bar.
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OSAS Text Functions  Introduction
• Use commands to access information screens or to toggle commands on and 
off. See “Commands and Flags” on page 1-28 for more information.

• If a screen contains more than one section, press PgDn when prompted to 
move to the next section.

• If a menu appears prompting you for the kind of information to enter or 
maintain (such as on Transaction or File Maintenance screens), select the 
appropriate option and press Enter.

• Press F7 to exit the screen and return to the main menu.

Text Function Screen Elements

Command Line

The command line appears at the bottom of the screen and gives you access to 
commands that allow you to move around the screen, add or edit information, 
change settings for selected lines, or select output devices. Press the highlighted 
key to use a command.

The commands that are available depend upon the function you are using. 
Consult the user’s manual for the appropriate application for information on 
commands in the command line.

Commands and Flags

Like the text menu, text function screens also contain several commands that 
allow you to perform tasks related to the function you are using. Some of these 
commands are not available for every function; when a command is available, a 
flag appears at the bottom of the screen.

Enter = edit, Append,  View,  Workstation ID,  Header
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OSAS Text FunctionsIntroduction
To access a command, press the corresponding key. If you’re working with a 
keyboard that lacks function keys (labeled with an F followed by a number) or if 
you’re working with an emulator in UNIX (which can cause function keys to 
become unavailable), press the appropriate alternate key combination to access 
the command.

Command 
Key

Alternate 
Key

Description

Enter Moves the cursor to the next field and accepts the 
data entered or access a line for editing.

Esc Opens a window listing available commands for 
the screen. 

Ins Toggles between insert and overwrite modes for 
entry. When the Ins flag appears, the characters 
you enter push other characters in the field to the 
right. If there is no Ins flag, the characters you 
enter overwrite other characters in the field.

PgUp Moves back to the first field on the screen (or the 
first field after the key field) without erasing any 
entries.

PgDn Approves the data on the screen, updates the data 
file accordingly, and proceeds to the next field or 
section.

Tab Moves the cursor to the next block or field that 
requires an entry.

Up/Down 
arrow

Moves the cursor up or down through the fields.

F1 (Help) Esc+H Opens the help description for the current field.
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F2 (Inquiry) Esc+W Opens the Inquiry screen for the current field. 
This command is available for a field when the 
Inquiry flag appears at the bottom of the screen. 
See “Inquiry Commands” on page 1-44 for more 
information.

F3 (Delete) Esc+D Deletes the current record or line item (when 
allowed).

F4 (Others) Esc+O Opens a utility menu similar to the Other 
Commands menu on graphical screens. See 
“Other Commands Menu” on page 1-22 for more 
information on the commands available.

F5 
(Abandon)

Esc+X Abandon processing or clear all fields.

F6 (Maint) Esc+F Opens the appropriate File Maintenance function 
where you can view or update master file 
information. This command is available when the 
Maint flag appears at the bottom of the screen.

F7 (Exit) Esc+M Exits from the function.

F8 (Print 
Screen)

Esc+L Allows you to output the current screen to a 
printer, to a print preview window, or to a file. 

F9 (Undo 
Typing)

Esc+U Clears the contents of the current field.

F10 (Delete) Ctrl+Z Deletes information to the end of the line.

Shift+F2 
(Info Menu)

Esc+I Opens an information menu for the function when 
the Info flag appears at the bottom of the screen. 
The commands that are available depend on the 
applications you have installed. See “Information 
Menu” on page 1-37 for more information.

Command 
Key

Alternate 
Key

Description
ODBC Kit User’s Manual1-30



OSAS Text FunctionsIntroduction
Shift+F3 Esc+B Uses the item alias lookup when the IN Search 
flag appears for an Item ID field. See “Inventory 
Lookup” on page 1-46 for more information.

In Sales Order, pressing this key combination 
allows you to enter purchase requisitions from the 
Ordered, Units, Shipped, and Backordered 
fields.

In sales tax fields, pressing this key combination 
allows you to view sales tax breakdowns.

Shift+F4 
(Part # 
Lookup)

Esc+C Uses the customer/vendor part number lookup 
when the IN Search flag appears for an Item ID 
field. See “Inventory Lookup” on page 1-46 for 
more information.

Shift+F5 
(Item Detail 
Lookup)

Esc+G Uses the item detail lookup when the IN Search 
flag appears for an Item ID field. See “Inventory 
Lookup” on page 1-46 for more information.

Shift+F6 
(Lot 
Lookup)

Esc+K Uses the lot lookup when the IN Search flag 
appears for an Item ID field. See “Inventory 
Lookup” on page 1-46 for more information.

Shift+F7 
(Serial 
Number 
Lookup)

Esc+N Uses the serial number lookup when the IN 
Search flag appears for an Item ID field. See 
“Inventory Lookup” on page 1-46 for more 
information.

Shift+F8 
(Item Descr. 
Lookup)

Esc+Q Uses the item description lookup when the IN 
Search flag appears for an Item ID field. See 
“Inventory Lookup” on page 1-46 for more 
information.

Command 
Key

Alternate 
Key

Description
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Messages

Messages appear at the bottom of the screen when a command is unavailable or 
when OSAS needs information to continue.

Ctrl+F 
(Quick 
Entry)

Toggles quick entry on and off. If this option is 
off, the cursor stops at every field possible. If you 
want to skip the fields that are not required (thus 
speeding data entry), turn this option on. Quick 
entry is on when the Quick flag appears at the 
bottom of the screen.

Ctrl+G 
(Bell)

Toggles the bell on or off. If the bell is on, it 
sounds at an error or when you must verify a 
command.

Ctrl+O 
(Online 
Hints)

Toggles function key display on and off. If this 
option is on, the available function keys appear at 
the bottom of the screen to remind you of their 
use.

Ctrl+V 
(Verify)

Toggles verification on and off. If verification is 
turned on, you must press a key twice to verify 
that you want to perform an operation. 
Verification is on when the Verify flag appears at 
the bottom of the screen.

Command 
Key

Alternate 
Key

Description
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On Windows workstations, you can choose to use the graphical mode for 
function screens. These screens contain all the functionality of text screens 
presented in a graphical mode similar to other Windows software programs.

You can move around the screen in these ways:

• Use the mouse or press Tab to move from field to field. Use the scroll 
buttons to move from line to line in scrolling regions.

• If a screen appears prompting for the kind of information to enter or 
maintain (such as on File Maintenance or Transactions screens), select the 
appropriate option and click OK to continue.

• Press PgDn if prompted to move to the next section.

• Click Header when it appears to return to the screen’s header section.

• Press F7 to exit the screen and return to the main menu.
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Graphical Function Screen Elements

Like the main menu, graphical function screens also contain pull-down menus 
and toolbars. These menus and toolbars are described below.

Function Pull-Down Menus

Commands Menu

Command Description

Inquiry      Lists valid entries for the current field.

Maintenance      Opens the appropriate File Maintenance function.

Proceed/OK      Proceeds to the next screen or saves your entries.

Start Over      Moves back to the first field on the screen or to the 
first field after the key field without erasing any entries 
or changes.

Field Up     Moves the cursor to the previous field.

Field Down     Moves the cursor to the next field.

Abandon     Clears data from all fields and moves the cursor to the 
first field on the screen.

Delete     Deletes information on the screen. Since this 
command deleted an entire record, use it with caution. 
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Edit Menu

Modes Menu

Select the options you want to use.

Jump      Moves the cursor to the next block of data on the 
screen or to the next field that requires an entry.

Exit       Exits from a screen or a window without saving data.

Command Description

Copy       Copies the contents of the current field.

Paste         Pastes the value you copied from a previous field into 
the current field.

Undo        Restores the contents of the current field from before 
you made changes to it.

Command Description

Command Description

Verify Exit When verification is on, you must press a key twice to 
verify that you want to exit or abandon functions.
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Other Commands Menu 

See “Other Commands Menu” on page 1-22 for information on this menu’s 
commands.

Help Menu

Bell When the bell is turned on, it sounds at an error or 
when you must verify a command. 

Quick When this option is off, the cursor stops at every field 
possible. To make the cursor skip the fields that do not 
require an entry in certain application functions, select 
the option.

Verify PgDown If verification is turned on, you must press PgDn twice 
to proceed to the next screen or to save your entries.

Command Description

Command Description

About OSAS Opens the About OSAS dialog box.

Command Help Opens the OSAS Key Help screen.
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Information Menu

The Information menu appears on some function screens in certain applications. 
The functions on the menu are determined by the applications installed.

The Information menu also gives you access to documents attached to customer, 
vendor, employee, invoice, or other records. When the Information menu 
appears, select the appropriate Documents command to open the Documents 
screen where you can view document information or open attached documents.

Help     Lists information about the field on which you are 
working. 

Online Doc      Launches your .PDF file viewer and opens the 
documentation for the appropriate OSAS application.

Command Description
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Scroll Commands Menu

The Scroll Commands menu appears only on screens with scroll regions.

Command Description

First Line      Moves the cursor to the first data entry field.

Previous Page     Displays the previous page.

Previous Line     Moves the cursor up to the previous line.

Next Line      Moves the cursor down to the following line.

Next Page      Displays the following page.

Last Line      Moves the cursor to the last data entry field.

Insert     Inserts characters between pre-existing entries in a 
field.

Delete       Deletes the selected characters.

Jump     Moves the cursor to the next section of the screen in 
some functions.
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Inventory Lookups Menu

If you use the Inventory application and the cursor is in an Item ID field, you can 
use any of the Inventory Lookups commands to search for information about 
items and select an item for entry in the field you are in.

Command Description

Alias Lookup    Searches for items with a specified alias listed as an 
alternate item. When you enter the alias, you can use 
the * and ? wildcard characters to restrict or widen the 
search.

Customer/Vendor 
Lookup        

Searches for an item based on customer ID or vendor 
ID. When you enter the customer or vendor ID, you 
can use the * and ? wildcard characters to restrict or 
widen the search.

Detail Lookup       Searches for detailed information about an item. You 
can enter search information in any of the fields that 
appear using any of the following wildcard characters 
to restrict or widen the search: * ? < > =.

Lot Lookup     Searches for an item based on lot number. When you 
enter the lot number, you can use the * and ? wildcard 
characters to restrict or widen the search.

Serial Lookup      Searches for an item based on serial number. When 
you enter the serial number, you can use the * and ? 
wildcard characters to restrict or widen the search.

Description Lookup      Searches for an item based on item description. When 
you enter the description, you can use the * and ? 
wildcard characters to restrict or widen the search.
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Function Screen Toolbar     

Like the main menu’s toolbar, the toolbar located near the top of function screens 
gives you quick access to frequently-used commands. Click the appropriate 
button to access a command. 

Button Result

Opens the appropriate File Maintenance function to update 
information about the field you are in.

Deletes the information on the screen. Since this command 
can delete an entire record, use it with caution. 

Moves the cursor back to the first field on the screen or to the 
first field after the key field without erasing any entries or 
changes.

Copies the contents of the current field.

Pastes the contents you copied from a previous field into the 
current field.

Opens the OSAS calculator screen.

Opens the pop-up calendar. Use the calendar to add and 
review reminders for any date.

Displays information about the field you are in.

Opens your .PDF file viewer so that you can view the online 
documentation.
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Right-Click Menu   

The right-click menu gives you quick access to commonly used commands such 
as those used to access help, move around the function screen, work with 
information on EIS dashboards, and so on. The commands that are available on 
the right-click menu depend on the function and the field you are currently using.

Function Field Inquiry

When the Inquiry button appears next to a field on a function screen, you can 
either click the  button or press the F2 (Inquiry) key to open the inquiry screen 
and search for information.

Verification Buttons

When you’ve completed data entry on a function screen, you can either click OK 
or press PgDn to proceed to the next screen or to save your entries. Click 
Abandon or press F5 to abandon entries.
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OSAS lets you navigate around the main menu and function screens in a variety 
of ways. This section describes the commands that are available when you access 
a specific command. For example, accessing the Help command makes the 
Maintenance and Exit commands available while you are in that function. This 
section also describes how to navigate within scroll regions and fields while you 
work with OSAS functions.

Help Commands 

When you use the Help (F1) command, you can use these commands.

Key Operation

F3 (Delete) Deletes the help screen content. To recover a deleted 
screen, copy the xxHELP file from the distribution 
media to the
/PROGxx subdirectory (xx is the application ID). The 
copying process overwrites changes you made to 
other help screens. 

In graphical mode, you must first press F6 to enter the 
edit screen for the help content before you can press 
F3.

F6 (Maintenance) Edits a help screen. 

F7 (Exit) Exits the help screen and closes the window.
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Inquiry Commands

When the Inquiry button  appears next to a field or the Inquiry flag appears in 
the lower-right corner of the screen, the Inquiry command is available. Click the 
button or press F2 to open the Inquiry screen to look up and select an appropriate 
entry. 

The Inquiry screen operates in two modes: Search and Sort. You can toggle 
between these modes within an Inquiry window by pressing the Ins (Insert) key. 
You can also choose the default mode for Inquiry windows by using the Defaults 
function on the Workstation Configuration menu within Resource Manager.

• In Search mode, you can move through the keys listed by typing 
progressively larger portions of the key you want to find. For example, when 
you press C, the window displays keys beginning with the letter C. When 
you next press A, the window displays keys beginning with CA, and so on. 

• In Sort mode, you can change the order of certain Inquiry windows by 
pressing the letter key associated with the window sort. You can see the 
available sorts in any Inquiry window by pressing Esc (Command Help).

Note

To shorten your data search, use a partial-key inquiry to cut down the size of 
the inquiry list. For example, if you know that the ID starts with JAR, enter 
JAR in the ID field before you use the Inquiry command. The Inquiry list 
starts with JAR and runs through the end of the list.
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The following commands are available inside Inquiry windows. The scroll 
buttons are available in graphical mode only.

Key Button Description

Home Moves directly to the first item on file.

PgUp Displays the previous page of the window.

Up Moves up one item.

Down Moves down one item.

PgDn Displays the next page of the window.

End Moves directly to the last item on file.

Ins 

(Look Up)

Toggles between Search mode and Sort mode.

F7 (Exit) Leaves the Inquiry window without selecting 
anything.

Enter Selects the item to which the cursor is pointing.

Esc 
(View 
Commands)

Opens a window that shows Inquiry window 
commands and the Window ID. The Esc key is 
available in text mode only.

In graphical mode, select Command Help from the 
Help menu to view a list of commands available.
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Inventory Lookup

If you use the Inventory application and the cursor is in an Item ID field on a 
function screen, you can use any of the Inventory Lookup commands to search 
for information about items and select an item for entry in the field. In graphical 
mode, these commands are available on the Inquiry Lookup menu. In text mode, 
the IN Search flag appears at the bottom of the screen to alert you that these 
commands are available.

Command Hot Key Operation

Alias 
Lookup

Shift+F3 Searches for items with a specified alias listed as 
an alternate item. When you enter the alias, you 
can use the * and ? wildcard characters to restrict 
or widen the search.

Customer/
Vendor 
Lookup

Shift+F4 Searches for an item based on customer or vendor 
ID. When you enter the ID, you can use the * and ? 
wildcard characters to restrict or widen the search.

Detail 
Lookup

Shift+F5 Searches for detailed information about an item. 
Enter information in any of the fields that appear, 
using these wildcards to restrict or widen the 
search: * ? < > =.

Lot Lookup Shift+F6 Searches for an item based on lot number. When 
you enter the lot number, you can use the * and ? 
wildcard characters to restrict or widen the search.

Serial 
Lookup

Shift+F7 Searches for an item based on serial number. 
When you enter the serial number, you can use the 
* and ? wildcard characters to restrict or widen the 
search.

Description 
Lookup

Shift+F8 Searches for an item based on item description. 
When you enter the description, you can use the * 
and ? wildcard characters to restrict or widen the 
search.
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Scroll Region Commands

When the prompt (>) is in a line-item scroll region, you can use the following 
commands. The buttons are available only in graphical mode.

In-Field Editing Commands

When the cursor is in a field that contains information, you can use the following 
commands:

Hot Key Button Operation

Home Moves to the first line item in the entire list.

Page Up Moves to the previous screen or to the first line if 
you are on the first screen.

Up Moves up one line item.

Down Moves down one line item.

Page 
Down 

Moves to the next screen or to the last line if you 
are on the last screen.

End Moves to the last line item in the entire list.

F3 Deletes the line item in the selected line.

Insert Inserts a line item at the selected line.

Enter Edits or views the line item in the selected line.

Hot Key Description

Right Moves the cursor to the right.

Left Moves the cursor to the left.

Delete Deletes the character the cursor is on.
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Insert Switches insert mode on and off. When the Insert 
flag appears at the bottom of the screen, characters 
you enter push characters after the cursor over. When 
insert mode is turned off, characters you enter write 
over existing ones.

Home Moves the cursor to the beginning of the field.

End Moves the cursor to the end of the field.

F9 (Undo) Restores a field to the way it was before you changed 
it. You can use this command only while you are in 
the field; once you move past it, you must use the 
Abandon (F5) command.

F10 
(Delete to End of 
Line)

Deletes the characters in the field to the right of the 
cursor. If insert mode is turned off and you enter a 
character in the field’s first position, everything in the 
field is deleted.

Shift+F9 
(Copy Field Contents)

Copies the contents of the current field.

Shift+F10
(Paste Field Contents)

Pastes the value you copied from a previous field into 
the current field.

Hot Key Description
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The Favorites menu operates in any of the menu formats and gives you quick 
and easy access to the OSAS functions you use most, allowing you to add 
selections for entire menus or particular functions. After you’ve set up the menu, 
you can access the functions either by pressing F2 or by selecting Change to 
Favorites from the graphical Favorites pull-down menu.

With the Favorites menu, you save time by eliminating the need to switch 
between applications. For example, if you perform tasks in several applications, 
such as using the Transactions and Cash Receipts function in Accounts 
Receivable, GL Account function in General Ledger, and Price and Availability 
and Item Inquiry functions in Inventory, you can set up a Favorites menu rather 
than moving between each application. The Favorites menu for the graphical 
main menu is illustrated below.

To set up the Favorites menu, do the following:

1. Select the function you want to add to the menu and press F10 (or use the 
right-click menu in graphical mode).

2. Press F2 to confirm that your selection was added.

To remove a function from the menu, follow these steps:

1. Select the function on the Favorites menu that you want to remove.

2. Press F10 (or use the right-click menu in graphical mode).
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The Information menu appears on some function screens in certain applications 
and gives you access to additional information about a customer, vendor, item, 
job, bill of material, or employee. 

The commands available on the Information menu are determined by the 
applications you have installed, and can include:

• General Information
• Comments
• History
• Documents

Not all of the commands above appear on every Information menu; instead, 
commands are available only as they are relevant to the task you are performing. 
For example, if you are entering a transaction in Accounts Receivable, you can 
access comments or documents about items or customers but not about 
employees or vendors.

Information

The Information command gives you general information about the subject. For 
customers, the Information command lists sale amounts and important dates, 
while for inventory items, the same command lists quantities, types, and base 
prices.

When the Information screen appears, enter the ID for which you want to view 
information. Use the commands available at the bottom of the screen to scroll 
between or select a new ID, then use the Exit (F7) command to return to the 
function screen from which you accessed the Information command.
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Comments

Use the Comments command when it appears to view comments added through 
File Maintenance functions or to add comments about a customer, item, vendor, 
employee, or job.

The Comments screen appears after you access the Comments command. The 
Customer Comments screen is shown below as an example.

1. Enter the ID for which you want to view or enter comments in the ID field at 
the top of the screen. The Inquiry (F2) command is available.

2. The ID of the terminal you are working at appears in the Ref ID field. To 
work with comments for only the default reference ID, press Enter. To work 
with comments for a different reference ID, enter that ID. To work with all 
comments, clear this field and press Enter.

3. Enter the date of the most recent comment you want to work with in the End 
Date field, or press Enter to work with all comments.
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The date, reference, and text that appear for each comment depend on the 
reference ID and end date you enter. The comments are arranged by date—
the most recent date first—then by reference ID.

4. Use these commands to work with the comments on the screen:

• Press R to return to the Ref ID field to enter a new reference ID.

• Press D to return to the End Date field and enter a new end date by 
which to sort comments.

• Press I to return to the ID field and enter a new ID for which to view or 
enter comments.

• Press A to add a new comment. The Append Comment screen appears.

• Press E to edit a selected comment. The Edit Comment screen appears.

• Press F to view comments for the first ID on record.

• Press N to view comments for the next ID on record.

• Press P to view or edit comments for the previous ID on record.

• Press L to view or edit comments for the last ID on record.

• Press G to go to a specific comment. This command is available only 
when there is more than one screen of comments.
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Adding or Editing Comments

The Append Comment screen appears when you add a new comment. The Edit 
Comments screen appears when you edit an existing comment. Other than the 
title, these screens are identical. 

1. If you are working with a new comment, the system date appears; otherwise, 
the date entered for the comment you are editing appears. Accept this date, 
or enter a different date.

2. The current terminal ID appears in the Reference field. Edit this reference, 
if necessary.

3. Enter or edit the comment, then press Enter to save the comment record.

History

When available, the History command gives you access to customer history in a 
manner similar to OSAS Inquiry functions. Select the customer for which you 
want to view detail information, enter a date from which to view information (if 
desired), then press Enter to view invoice or payment information.

Use the commands at the bottom of the screen to switch between or change 
customers, view totals, or select the line item to view. Use the Exit (F7) 
command to return to the function screen from which you accessed the History 
command.
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Documents

The Documents command lets you view or open documents attached to certain 
master file records. You cannot use this command to attach a document to a 
record; instead, use the appropriate File Maintenance function to attach 
documents.

Note

Before you can open documents, you need to have the appropriate file 
associations set up in the File Types function on the Resource Manager 
Workstation Configuration menu. The entries you make in this function 
help OSAS identify which software applications to use to open attached 
documents. See the Resource Manager User’s Manual for more information.

The Documents screen appears after you access the Documents command. The 
Employee Documents screen is shown below as an example.
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Enter the ID for which you want to view attached documents. The Inquiry (F2) 
command is available.

Use these commands to view document information, open an attached document, 
or switch between or select a new ID:

• Press H to return to the header section to select a new ID.

• Press F to view documents attached to the first ID on record.

• Press L to view documents attached to the last ID on record.

• Press N to view documents attached to the next ID on record.

• Press P to view documents attached to the previous ID on record.

• Press V to view document information. The View Documents screen appears 
and lists the file name, directory path, and description of the attached 
document. Press any key to return to the Documents screen.

• Press O to open the attached document in the appropriate software 
application. You may need to edit the Resource Manager File Types function 
in order to associate files with your preferred applications.

Note

If you have problems opening a document, return to the function in which 
the document was attached and edit the attachment to change the direction of 
the slashes used in the directory path. If the directory path contains backward 
slashes (\), change them to forward slashes (/) and vice versa.

• Press G to go to a specific document line. This command is available only 
when there is more than one screen of line items.

Use the Exit (F7) command to return to the function screen from which you 
accessed the Documents command when you finished viewing documents.
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Selecting a Range of Information

To produce a report, you must specify the amount of information you want in the 
report. 

• To produce a report that includes all the available information, leave the 
From-Thru fields on the report screen blank. For example, if you want 
information about all the vendors to be in a report, leave the Vendor ID From 
and Thru fields blank.

• To limit the amount of information in the report, enter the range of 
information in the From-Thru fields. For example, if you want a report to 
include information only about vendor ACE001, enter ACE001 at both 
From and Thru. If you want the report to include information only about 
vendors that start with CO, enter CO at From and COZZZZ at Thru.

Each field where you enter information on a report screen usually restricts the 
overall output of the report. For example, if you leave the Vendor ID From and 
Thru fields blank, the report contains information about all the vendors. But if 
you enter invoice 100 in the Invoice Number From and Thru fields, and invoice 
100 is assigned only to vendor ACE001, the report includes information only 
about vendor ACE001.

Sorting

Information for reports is sorted first by a space (_), then by special characters, 
then by digits, then by uppercase letters, and finally by lowercase letters. No 
matter what you enter in the From and Thru fields, however, your entries are 
sorted in alphabetical order (unless the function provides an option to sort the 
information differently).

Sorting by alphabetical codes or IDs is easy. For example, the ID ACL comes 
before the ID BB because A comes before B.
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Use caution when you enter codes or IDs consisting of characters other than 
letters; the order might not be what you expect. For example, if 20 items are 
labeled 1 through 20, and all are included in a report, you might enter 1 at From 
and 20 at Thru, expecting them to be listed 1, 2, 3. . . 19, 20. However, since 
OSAS sorts in alphabetical order, the numbers are listed in this order: 1, 10–19, 
2, 20. In this example, numbers 3 - 9 are not included in the sort since they fall 
after 20 in an alphabetical sort. To prevent this situation, pad extra spaces in 
codes and IDs with zeros so that numbers in alphabetical order are also in 
numerical order. In the example above, the items would be labeled 000001 
through 000020.

Output the Report

The type of menus you use controls which options are available to output reports. 
If you are using graphical function screens, you have the following output 
options: Printer, Print Preview, File, or E-mail (for selected reports). If you are 
using text function screens, you have these options: Printer, Preview, File, 
Screen, or E-mail (for selected reports). See the following instructions for 
details.

If you are using graphical screens, the Output Information dialog box appears 
after you select the range of information to print in the report.

If you are using text screens, these options appear at the bottom of the screen 
after you select what to print in the report and how it is organized.
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Print the Report

1. Select Printer (in graphical screens) or enter P (in text screens).

2. If multiple printers are available for the terminal, either select the printer 
from the list or enter the appropriate code for the printer and press Enter.

Use the Devices function on the Resource Manager Workstation 
Configuration menu to add printers to the terminal.

3. When available, either select Standard or enter S if you want to print the 
report in standard width or select Compressed or enter C if you want to 
print it in compressed width.

4. Click OK or press Enter to begin printing the report.

5. If you want to stop printing after it has begun, press Ctrl+Break.

6. Click OK or press Enter to continue. 

View the Report using Print Preview (Windows Workstations Only)

The Print Preview option is only available for workstations running Windows. 
However, before Print Preview will work, you must add a sysprint device line in 
the config.bbx file for that printer. Use the Devices function on the Resource 
Manager Workstation Configuration menu to add this line. 

Follow these steps to view a report using Print Preview:

1. Select Print Preview (in graphical screens) or enter R (in text screens).

2. If multiple printers are available for the terminal, either select the printer 
from the list or enter the appropriate code for the printer and press Enter.

Use the Devices function on the Resource Manager Workstation 
Configuration menu to add printers to the terminal.

3. Click OK or press Enter to continue. 
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4. When available, either select Standard or enter S if you want to view the 
report in standard width or select Compressed or enter C if you want to 
view it in compressed width.

5. Press Enter. The Print Preview screen displays the report as it will look 
when printed out in hard copy.

6. To print from this screen, select Print from the File menu. To exit from this 
screen, select Exit from the File menu.

Save the Report as a File

To save the report as a text file, select File or enter F. The data path set up for the 
workstation in the Defaults function on the Resource Manager Workstation 
Configuration menu appears. If necessary, enter a new data path or click the 
Browse button to navigate to the correct directory, then enter the file name 
followed by the .txt extension. The file name plus extension that you enter must 
be less than 35 characters. Press Enter to save the report in that directory.

View the Report on Screen (Text Screens Only)

If you are using text screens, you can view selected reports directly in the OSAS 
screen. Keep in mind that this option displays the report one page at a time, 
storing previously viewed pages in the workstation’s memory. Use the Defaults 
function on the Resource Manager Workstation Configuration menu to limit the 
number of screen pages you can view to conserve memory resources.

Follow these steps to view the report on screen:

1. Enter S to select (S)creen.

2. When available, enter S if you want to view the report in standard width or C 
if you want to view it in compressed width.

3. When the report appears, press Enter to view the next page or Page Up to 
view previous pages.
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E-mail the Report

Before you can e-mail reports, you must enter details about your e-mail system 
using the E-Mail Setup function on the Resource Manager System File 
Maintenance menu. 

You can e-mail only selected reports. In general, any report or form that makes 
up part of your audit trail cannot be e-mailed. 

Follow these steps to e-mail a report:

1. Select E-mail or enter M.

2. When available, select Standard or enter S if you want to e-mail a standard 
width report or select Compressed or enter C if you want to e-mail it in 
compressed width. The E-Mail Information screen appears.

3. If you e-mailed this report previously, the last e-mail address to which you 
sent the report appears. Press Enter to use this address, change it if 
necessary, or enter a new e-mail address.

4. Enter another address to send the e-mail to as a carbon copy, if necessary.

5. OSAS automatically enters the name of the report in the Subject field. 
Change this subject line, if necessary.

6. Select the Attachment check box (or enter Y in text mode) to send the report 
as a text file attachment to the e-mail message. If you clear this box (or enter 
N in text mode), the report is sent in the body of the e-mail.

7. Click OK or press Enter to e-mail the report.
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Report Commands

Use the following commands when a report appears on the screen:

Key Operation

PgUp Moves to the previous page of the report. 

PgDn Moves to the next page of the report. 

Home Moves directly to the top of a group of pages.

End Moves directly to the bottom of a group of pages.

F7 (Exit) Exits to the menu from any point in the report.

Left Moves left one character.

Right Moves right one character.

Tab (Toggle) Toggles between the left and right halves of a report.

Up/Down Moves a line up and down the screen to line up 
information when you toggle between halves of a 
report.
ODBC Kit User’s Manual1-62



ODBC Kit User’s Manual
Installation

Installing BASIS™ ODBC Drivers 2-3
Installation For Windows 95/98/NT/20002-5
Installing ODBC Drivers 2-19

2

ODBC Kit User’s Manual 2-1





Installing BASIS™ ODBC Drivers

Follow these steps to install and set up the ODBC Kit on your computer:

1. Use Resource Manager to install the OSAS ODBC Kit on your computer. 
See the Resource Manager Installation Manual for installation instructions.

2. Use the Edit CONFIG.TPM function (page 3-3) to set up a configuration file 
pointing to a company.

3. Install the BASIS ODBC drivers. The BASIS ODBC driver is a 32-bit driver 
for Windows 95/98, Windows NT, and Windows 2000. Installing the drivers 
is a two-step process: you must first install the drivers on the computer, then 
run a separate installation program to install the drivers into the operating 
system. 

Note

If you have not installed the Windows ODBC Administrator, you may need 
the Windows installation disks or CDROM. Windows prompts you for the 
required media if it is necessary.

Note

If you have single-user ODBC serial and authorization numbers, use the 
instructions below to install and register the ODBC drivers.

If you have a multiuser key, you must use the BASIS License Manager, and 
you need to register and install the license through the License Manager. 
Follow the instructions in the Reregistering/Reinstalling a BASIS License 
section in chapter 2 of the Resource Manager Installation Manual to install 
the License. Then continue with the instructions below.
ODBC Kit User’s Manual 2-3





Installation For Windows 95/98/NT/2000

1. Start Microsoft Windows.

2. Insert the OSAS CD into your CD-ROM drive. The installation screen 
(shown below) should appear automatically. If it does, continue with step 6 
to install ODBC. If the installation screen does not appear, continue to step 
3.

3.  Click Start and select Run.

4. Type the letter of the CD-ROM drive, a colon, and a backslash. Then type 
autorun to start the setup program. For example,

d:\autorun

5. Click OK. The Main Installation screen appears:
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6. Click the Install Basis Products button. The Install Basis Products dialog 
box appears.

7. Click BASIS ODBC Driver.

8. The Choose Setup Language box appears. Select the language and click OK.

9. The BASIS Welcome screen appears next. Read the text carefully and click 
Next to continue.
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10. The Software License Agreement screen appears. After you read the 
Software License Agreement screen text, click Yes to accept the agreement.

11. The Setup Type screen gives you three choices as to how to install your 
ODBC software. For new installations, Typical is recommended.
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The destination folder automatically defaults to your C: drive. If you want to 
install ODBC on another local drive, click Browse and navigate to the folder 
you want to use.

Typical Setup

12. The Select Program Folder screen adds a folder on the drive you selected 
and adds a shortcut for your ODBC driver. Click Next.

The BASIS ODBC Driver 3.01 folder is created and the file copy begins.
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13. You must now register for a BASIS license. If you have not installed a 
license, click Next and proceed to step 14. If you have already received your 
license file, or if you are using the BASIS License Manager, check the box, 
click Next, and continue to step 18 on on page 2-13.
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14. In the License Registration Information screen fields, enter the information 
requested. The Serial Number and Authorization Number can be found on 
the BASIS License Registration Form that was included with the media. 
Click Next when finished.
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15. The License Registration and Delivery Methods screen appears. If the 
computer is connected to the Internet, use the default Web Browser option 
as the registration method. If you choose any other registration method, 
follow the appropriate steps in Appendix G. Click Next. 

16. The License Information Confirmation screen appears. Check the Serial and 
Authorization Numbers with those on your License Registration Form and 
click OK. 
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17. Using the default web browser on your computer, your registration 
information is sent to Basis and a text file (see example below) is returned to 
your browser from Basis.   

Once you receive the information, follow these instructions:

• Save the page as instructed. If the Temp directory does not exist, create 
it and save the text file in that directory.

• Return to the BASIS ODBC Driver 3.01 folder window (created in step 
12) and double-click the Install a BASIS License icon. 

If you closed this window, click Start, point to Programs, then to Basis 
ODBC Driver 3.01, and then select Install a Basis License from the 
menu that appears.
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License Installation

18. If you have already received the license.txt file, or you are using the BASIS 
License Manager, this screen appears. Click Yes.

19. The Install a BASIS License screen appears.

If you are using a single-user key and you have already received the license 
file, click Next. Then continue with step 20.

If you are using the BASIS License Manager, click Configure this 
application to use the BASIS License Manager, then click Next. Skip to 
step 23.
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20. The Locate License File screen appears. Enter the path for the license.txt file 
or click Browse to navigate to the \Temp directory where it is stored. See the 
example below..   

Click Open to enter the directory path in the Licence File text box on the 
Basis License Installation screen (shown above), then click Next to continue.
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21. After you have located the license.txt file, the Installation Successful screen 
appears.

Click Yes to install another license and return to the the BASIS License 
screen. Click No to continue. 

22. If you use OSASCS for Windows or UNIX/Linux, enter the name of the 
server that is running the Data Server. If you are using standard OSAS or 
OSASCS for Novell, leave the field blank.

In either case, click Next and skip to step 25.
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23. If you are using the BASIS License Manager, the following screen appears. 
Enter the name the server that is running the BASIS License Manager and 
click Next.

24. The Installation Successful screen appears. Click OK to continue.
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25. Click Finish.

26. If you do not want to view the readme.txt file, clear the box. Otherwise, click 
Finish. 
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27. Before you use the ODBC driver you must:

• install the ODBC Kit from your OSAS media

• create the config.tmp file (see page 3-3)

Once you have completed these two steps, follow the instructions on on 
page 2-19.
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After installing the ODBC media, you need to create and setup your ODBC 
drivers.

1. Click Start, point to Settings, then select Control Panel from the menu that 
appears. When the Control Panel opens, double-click the 32 bit ODBC 
Administrator icon.

2. On the ODBC Data Source Administrator screen, select the File DSN tab and 
click Add.
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3. Select the Basis ODBC Driver entry and click Next. 

4. Enter the name for your ODBC driver, such as OSAS ODBC as in the 
example below. Click Next.
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5. The next screen lists the information you have entered for confirmation. 
Verify that it is correct and click Finish. If the information is incorrect, click 
Back and reenter the information as needed.
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6. The Driver Data Source Configuration screen appears next. In the Database 
field, enter the path for your config.tpm file.

Click Browse to navigate to the directory in which the config.tpm file is 
stored.

7. To enhance the usability of your ODBC driver, select the Pad variable 
length column with spaces check box.

If you are allowing only read access, select the Read Only Access check 
box.

Click OK to continue.
ODBC Kit User’s Manual2-22



Installing ODBC DriversInstallation
8. Click OK to finish the ODBC setup procedure. For more information on how 
to manipulate data from within another application, see one of the following:

Microsoft Access Appendix A

Microsoft Excel Appendix B

Microsoft Query Appendix C

Microsoft Word Appendix D

Crystal Reports Appendix E
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Edit CONFIG.TPM

Use the Edit CONFIG.TPM function to create and edit database configuration 
files for the BASIS ODBC driver. 

You must create a database configuration file for each company you want to 
access with the ODBC driver. If you have multiple companies, name each 
configuration file with some variation of the company ID and the TPM file 
extension. For example, if the company ID is HHH, the configuration file’s name 
would be CONFGHHH.TPM.

Note

If you want to use the report applets (Microsoft Excel spreadsheets) that 
come with the ODBC Kit, you must store your configuration file in the 
WINDOWS directory on the C: drive of each computer where the ODBC 
driver is installed.

Enter the file path and database configuration file name in the Database 
Configuration field in the BASIS ODBC Driver Data Source Setup dialog box 
when you install the BASIS ODBC driver or when you access OSAS data using 
the BASIS ODBC driver.     
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Follow these steps to edit the CONFIG.TPM file:

1. Select Edit CONFIG.TPM from the ODBC Kit menu in OSAS. The Edit 
CONFIG.TPM screen appears.

2. Enter the file path and name of the database configuration file you want to 
edit. Enter a \ at the end of the directory path.

If you enter a new path or database configuration file name, a skeleton file is 
built.

3. The variables and their related data appear in the scroll region. Press Enter 
to edit the variables:

• DICTIONARY – Enter the file path to the data dictionary files.
• DATA – Enter the file path to the company data.
• CID – Enter the company ID for the database configuration file.
• SYSFIL – Enter the file path to the system data files.
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4. Use the commands to add a new variable or save your changes:

• Press A to add a new variable to the list.

• Press W to save your changes.

• Press C to save your changes to a new configuration file.

5. To save your entries and exit to the main menu, press W and then use the Exit 
(F7) command.
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Introduction

The functions on the Dictionary Tools menu can help you perform these tasks:

• Use the Copy File(s) to Dictionary function to copy definitions from one 
dictionary to another.

• Use the Files function to set up data dictionary information, create views of 
OSAS data files, and delete file definitions as needed.

• Use the Fields function to define and edit fields in the data dictionary files.

• Use the Indexes function to define the keys used in OSAS Mkeyed data 
files.

• Use the Add/Change Reserved Words function to add or update the words 
you want to flag as reserved.

• Use the Tables function to set up and maintain the ODBC Kit table.
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Copy File(s) To Dictionary

Use the Copy File(s) To Dictionary function to copy file, field, and index 
definitions from one data dictionary to another.

Follow these steps to copy definitions:

1. Select Copy File(s) to Dictionary from the Dictionary Tools menu. The 
Copy File(s) to Dictionary screen appears.

2. Enter the data dictionary extension from which you want to copy definitions.

3. Enter the data dictionary extension to which you want to copy definitions.

4. Select the type of information to copy: All Application Files, a Specific 
File, or Base Dictionary Files.
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5. If you elected to copy all application files, enter the application from which 
you want to copy file information.

If you elected to copy a specific file, enter the name of the file from which to 
copy information and the name of the destination file.

6. Use the Proceed (OK) command to copy the definitions you selected.

7. To exit to the main menu, use the Exit (F7) command.
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Use the Files function to set up and maintain data dictionary information about 
the data files used in OSAS programs, to construct views of the OSAS data files, 
and to delete unnecessary file definitions from the data dictionary. Back up data 
dictionary files—files with .1 as the file extension—before you delete, modify, or 
create files in case you make mistakes.

A view is a structured query language (SQL) term that represents a glimpse at the 
data contained in your files. The fields in a view can be from more than one file. 
Views can also have criteria applied. For example, a view can include vendor 
names and mailing addresses for a form letter, but include only vendors in a 
selected state. You should be familiar with SQL or become familiar with the 
predefined views in the data dictionary before you create new views.

You should be familiar with BBx field and file types in order to append files to 
the data dictionary. Back up your data dictionary files before you create files; this 
lets you restore the dictionaries if problems occur.

Use the Files function to delete unnecessary file definitions from your data 
dictionary to increase performance and decrease the amount of disk space used 
by the shadow dictionary.
ODBC Kit User’s Manual 4-7



Files  Dictionary Tools
Select Files from the Dictionary Tools menu. The Files screen appears and lists 
information about the files in the data dictionary.

Each entry shows you the file name, description, type (Mkeyed or Indexed), 
record length, number of records, and number of keys for that file in the data 
dictionary.

Use the commands to work with the files in the dictionary:

• Press Enter to edit information about the selected entry. The Edit File screen 
(page 4-9) appears.

• Press A to add a file to the list. The Append File screen (page 4-9) appears.

• Press G to go to a specific file in the list.

• Use the Exit (F7) command to save your changes and return to the main 
menu.
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Append/Edit File Screen

The Append File screen appears when you add a new file to the list. The Edit File 
screen appears when you edit an existing file in the data dictionary. Other than 
the names, these two screens are identical. The Edit File screen is shown below.

1. Enter the File Name and Description.

2. If the file is a view, select the View Definition? check box (or enter Y in text 
mode); if not, clear the box (or enter N in text mode).

3. Enter the file type:

I = Indexed
L = Serial
K = Keyed
S = String
P = Program
D = Directory
M = Mkeyed

4. Enter the file record length and number of records the file contains.
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5. Enter the Key Size if the file is a single keyed or Mkeyed file.

6. Enter the File Index on which the file is usually opened.

7. Enter the GENERAL Report Writer topic within OSAS software.

8. Enter the Long File Name for the file.

9. Enter the path ODBC uses to see the file. Use the variables (DATA) to 
specify the data path and (CID) to specify a company-specific file. These 
variables are defined in the CONFIG.TPM file.

10. Enter the application ID for the file.

11. If the file is a view, press PgDn to enter the SQL WHERE clause selection 
criteria used to select the data in the view. See “Edit File View Information 
Screen” on page 4-11 for more information.

12. Use the Proceed (OK) command to save your changes and return to the Files 
screen.
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Edit File View Information Screen

The Edit File View Information screen appears when you add or edit a view and 
then press PgDn to view the WHERE clause that selects data for the view.

The screen lists the WHERE clause selection criteria and the files from which 
fields are drawn to make up the view.

1. Enter or edit the SQL WHERE clause selection criteria. Use single quotation 
marks around strings. For example, a valid clause might be:

APVE.VENDORID = ‘ACE001’

2. Press Enter to continue to the File Name section to specify the files to 
include in the view.

3. Use the commands to work with files:

• Press A to add a new file to the list.
• Press W to save your changes and return to the Files screen.
• Press S to return to the Where Clause field.
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Fields

Use the Fields function to define and edit the fields in the data dictionary files. 

Unless you are working with views, you must be familiar with BBx field types 
and the file layout in order to define fields. If you are working with a view, build 
the field definitions from existing files with the Build view from file command.

Select Fields from the Dictionary Tools menu. The Fields screen appears.

After you select a File Name and press Enter, the screen lists the file size and soft 
size—the total of all field lengths added together plus the total number of fields 
in the file—and the field name, description, field type, and notes for all fields 
contained in the file.
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Use the commands to work with the fields in the file:

• Press Enter to edit the selected entry. The Edit Fields screen appears.

• Press A to add a new field to the list. The Append Fields screen appears.

• Press W to save your changes.

• Press B to build fields from a file. This command is only available when the 
selected entry is a view. Enter the file name from which to build the fields in 
the Enter File to Copy From field that appears and press Enter.

• Press G to go to a specific field in the list.

To save your entries and return to the main menu, press W and then use the Exit 
(F7) command.

Append/Edit Fields Screen

The Append Fields screen appears when you add a new field to the list; the Edit 
Fields screen appears when you edit an existing field. Other than the name, these 
screens are identical.
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1. Enter the Field ID. Any word you enter is checked agains the reserved word 
file, and a warning appears if you enter a reserved word. A reserved word is 
a key word from a third-party ODBC and SQL language that should not be 
used for field names.

2. Enter the field’s Description.

3. If you edited a field from a view, the Orig. Field field appears and lists the 
file the field was pulled from for the view and the original field name. Edit 
this information, if necessary. 

This field does not appear for regular fields contained within files.

4. Enter the Field Type:

C = Character
N = Numeric
U = Unsigned Integer
I = Signed Integer
F = IEEE Float
D = BCD Float
B = Business Math
X = ‘C’ Float
Y = ‘C’ Double

5. In the Numeric Type field, enter B if the numeric is a Boolean, J if the 
numeric is a date, or O if the numeric is any other numeric. If the field type is 
non-numeric, this field is not available.

6. If the field is of variable length and requires a field terminator, select the 
Variable Length? check box (or enter Y in text mode); if not, clear the check 
box (or enter N in text mode).

7. Enter the length of the field in bytes in the Field Length field. The Array 
Elements field is set to 1 and cannot be changed.

8. Enter the name to be used for the field in GENERAL Report Writer in the 
RW Name field.
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9. In the Variable field, enter the variable ID to be used to represent the field. 
IF this application uses string templates, leave the field blank.

10. Enter the string template ID.

11. Enter any descriptive notes about the field in the Notes fields.

12. To save your entries, use the Proceed (OK) command. You are returned to 
the Fields screen. Press W to save your changes to the file.

Other files are scanned for field names that match any you changed. If data 
changes have been made, the Update Fields screen appears to update other 
fields with changed data.

• Enter Automatic (or press A) to automatically update fields through the 
system; enter Prompt (or press P) if you want to be prompted for every 
field to be appended or changed.

• If you want to update the type of information listed in related fields with 
your changes, select the check box or enter Y; if not, clear the check box 
or enter N.

• Use the Proceed (OK) command to update related fields. If you selected 
Prompt or entered P, you are prompted to enter the information you 
want to update for each related field.
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Use the Indexes function to define the keys used in OSAS Mkeyed data files. 
You must be familiar with BBx field and file types in order to use this function.

Select Indexes from the Dictionary Tools menu. The Indexes screen appears.

After you select the File Name, the screen lists key order number (KNUM) and 
key definition for all index keys defined for that file.

Use the commands to work with the indexes in the file:

• Press Enter to edit the selected index. The Edit Indexes screen appears.
• Press A to add a new index to the list. The Append Indexes screen appears.
• Press C to switch between the field view and key segment view of the file.
• Press W to save your changes.
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Append/Edit Indexes Screen

The Append Indexes screen appears when you add a new index to the file. The 
Edit Indexes screen appears when you edit an existing index. Other than the title, 
these screens are identical.

You cannot edit the index segments in the scroll region directly. Instead, press 
Enter to edit an index entry. For descriptions of each of the fields on this screen, 
see “Append/Edit Segments Screen” on page 4-19.

Use the commands to work with the segments that make up the index key:

• Press Enter to edit the selected segment. The Edit Segments screen appears.

• Press A to add a new index segment to the list. The Append Segments screen 
appears.

• Press D to return to the Index ID field to edit the index description.

Use the Exit (F7) command to save any changes and return to the Indexes screen.
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Append/Edit Segments Screen

The Append Segments screen appears when you add an index segment to the list 
on the Edit Indexes screen; the Edit Segments screen appears when you edit an 
existing segment. Other than the title, these screens are identical.

1. The segment’s Sequence number appears and cannot be changed. To change 
this number, return to the Append/Edit Indexes screen and use the Delete 
(F3) and Append commands to rearrange segment entries.

2. Enter the field name to use in the segment, or leave the field blank if the 
segment consists of more than one field. If you enter a field name, the 
following information appears and cannot be changed. Use the Fields 
function (page 4-13) to edit this information.

• Description
• Type (C for character, N for numeric)
• Field number
• Starting position of the field in a string
• Total length of the field

3. Select the Descending? check box (or enter Y in text mode) if the field is in 
descending sort order; if not, clear the check box (or enter N).

4. Select the Unique? check box (or enter Y) if the field is a unique field; if not, 
clear the check box (or enter N). Enter N for standard OSAS files.
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5. Select the Business? check box (or enter Y) if the field is a business math 
type and must be sorted as such; if not, clear the check box (or enter N). 
Enter N for standard OSAS files.

Your choices for the above three options appear on the Append/Edit Indexes 
screen.

6. Use the Proceed (OK) command to save your changes and return to the 
Append/Edit Indexes screen.
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Use the Add/Change Reserved Words function to add or update the file of 
reserved Structured Query Language (SQL) words or to other words you want 
flagged as reserved. You cannot use reserved words as field IDs or names.

To add or change reserved words:

1. Select Add/Change Reserved Words from the Dictionary Tools menu. The 
Add/Change Reserved Words screen appears.

2. Enter the word to add or edit in the Reserved Word field.

3. Enter or edit the reserved word’s description.

4. To delete a reserved word, use the Delete (F3) command.

5. Use the Proceed (OK) command to save your changes and return to the 
main menu.
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Tables

Use the Tables function to set up and maintain the ODBC Kit table. Tables store 
information about the system, data, options, and default settings for other 
applications. 

The ODEXTxxx and OPT tables are related to the ODBC Kit. For more 
information about the ODEXTxxx table, see its description in this section. 

The OPT (Options) tables store options and interfaces settings. Maintain the 
information stored in this table through the Options and Interfaces function on 
the Resource Manager Company Setup menu, not through the table itself.

ODEXTxxx Table

The ODEXTxxx table stores the data dictionary file extension in use for the 
current terminal, where xxx is the current terminal ID. Follow these steps to 
access the table and change the file extension, if necessary:

1. Select Tables from the Dictionary Tools menu. The Tables screen appears.
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You can use this screen to add a new table, copy an existing table, delete a 
table, or set up terminal-specific or company-specific tables. See the 
Resource Manager User’s Manual for more information.

2. Enter ODEXTxxx (where xxx is the current terminal ID) in the Table ID 
field. The remainder of the ODEXT field appears.

3. Change the data dictionary file extension (1 in the above example) for the 
current terminal as necessary.

4. Use the Proceed (OK) command to save your changes, then use the Exit 
(F7) command to return to the main menu.
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Printing a Dictionary Report

Use the functions in this chapter to print reports that contain information about 
the information in your data dictionary. The following reports are available:

• Use the Dictionary Field List function to print a report listing all field names 
across files for verification and consistency. 

• Use the Audit Field Names for Reserved Words function to check for the 
use of reserved words in applications.

• Use the Reserved Words List function to print a list of all reserved words in 
the data dictionary.

All dictionary reports are produced in the same way. Use the instructions on the 
next page to print a report, modifying the procedure as necessary for the report 
you are printing. For example, if the screen for the report you want to print does 
not contain sort by options, ignore that step and continue to the next.
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Follow these steps to print a dictionary report:

1. Select the report you want to print from the Dictionary Reports menu. The 
selection screen for that report appears. The Dictionary Field List screen is 
shown below as an example.

2. Select the range of information to include in the list in the From and Thru 
fields. The Inquiry (F2) command is usually available for these fields to let 
you select beginning and end range values from the list that appears.

Leave these fields blank to include all values in the list.

3. If the screen contains options that control how information is sorted, select 
the option you want to use to sort the information. You can select only one 
sort option.

4. Select the output device to begin printing the report. See “Output the Report” 
on page 1-58 for more information. After the report is produced, the 
Dictionary Reports menu appears.
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Dictionary Field List

Use the Dictionary Field List function to produce a printout by field name across 
files. Use the list to verify the consistency of field names in related files.

Dictionary Field List
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Audit Field Names For Reserved Words

Use the Audit Field Names for Reserved Words function to validate an 
application for reserved words or check all applications for reserved words.

Audit Field Names For Reserved Words List
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Reserved Words List

Use the Reserved Words List function to printout a list of all the reserved SQL 
words.

Reserved Words List
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Microsoft Access

This appendix walks you through opening a simple form using the ODBC Kit 
with Microsoft Access 97 and higher. If you require more information about 
Microsoft Access, consult the Microsoft Access User’s Guide or Online Help.

Please note that the appendix uses Microsoft Access 97 in the example 
illustrations. If you are using a more recent version of Access, the commands and 
interface may differ slightly.

Before you can create this report, complete these tasks:

• Install and set up the ODBC Kit.
• Install and set up the BASIS ODBC drivers.
• Install Microsoft Access.

The Microsoft Access example—ACCEXAMP.MDB—which contains two 
reports and two inquiry forms is included in the ODBC Kit.

You can find additional information about using ODBC with Microsoft Access 
on the Open Systems web page on the Internet at http:\\www.osas.com.

A
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To Work With a Sample Form

1. Start Microsoft Access. If you have security set up, enter your user name and 
password.The Microsoft Access dialog box appears.

2. Select the sample database, ProfitHistory.mdb (listed in the example above 
as ACCEXAMP). Click More Files to navigate to the database, if necessary.

3. The database container appears.
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To Link Tables to Microsoft Access

If you encounter problems with the existing table links in the sample data base, 
delete them and follow these steps:

1. From the File menu, select Get External Data and Link Tables, or right-
click the database container and select Link Tables from the menu that 
appears. The Link dialog box appears.
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2. Select ODBC Database in the Files of type list box. The Select Data Source 
dialog box appears.

3. Click the Machine Data Source tab.
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4. If you have set up an OSAS ODBC machine data source, select it and click 
OK. Otherwise, click New.

Clicking New starts a data source creation wizard that will guide you 
through the process for setting up a new data source. Refer to chapter 2 for 
instructions on creating a new data source.

The BASIS ODBC Driver Data Source Setup screen appears.

5. Enter a name and description for the data source. Click Browse to locate the 
CONFIG.TPM file you set up using the Edit CONFIG.TPM function (page 
3-3) in OSAS.
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If you have used the ODBC drivers and already created the shadow 
dictionaries, click Advanced. In the additional fields that appear, select the 
No Shadow Dictionary Consistency Check and the Fast Connect check 
boxes to increase the performance of the ODBC drivers. 

Note

If you are using OSASCS and you use the data server to access your data, 
enter your login name in the Network User ID field.

6. Click OK to connect to the data source. The Link Tables screen appears.

7. Select the following tables for the samples in the sample database:

• ARCU
• ARHS_2
• ARHS_CUSTOMER
• INHS
• INHS_PERIOD
• INLO
• INVE
• PADD
• PADE
• PAEG
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8. Click OK. As the OSAS files are linked to the Microsoft Access database, 
you are prompted for keyed fields in the OSAS files. Select the keyed fields 
in the dialog box that appear.

You are returned to Microsoft Access. The linked tables appear.

9. Click the Forms tab.

10. Click frmCustHistLookup on the Forms tab. The Customer History Form 
appears.
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11. Select a Customer ID and enter a Year. Then click Preview Graph. The 
graph for that customer and year appears.

To Work With Sample Queries

To work with sample queries in the Microsoft Access database, click the Queries 
tab and select the query you want to work with.

To Work With Sample Reports

To work with sample reports in the Microsoft Access database, click the Reports 
tab and select the report you want to work with.
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This appendix walks you through creating a pivot table using the ODBC Kit and 
Microsoft Excel 97 and higher. If you require more information about Microsoft 
Excel, consult the Microsoft Excel User’s Guide or Online Help.

Please note that the appendix uses Microsoft Excel 97 in the example 
illustrations. If you are using a more recent version of Excel, the commands and 
interface may differ slightly.

Before you can create this report, complete these tasks:

• Install and set up the ODBC Kit.
• Install and set up the BASIS ODBC drivers.
• Install Microsoft Excel and Microsoft Query.

The following Microsoft Excel examples are included in the ODBC Kit:

• GLACCT.XLS—GL Account Number Lookup.
• PIVOT.DOC—Instructions for setting up an Excel Pivot table.
• SOORDERS.XLS—Sales Orders Pivot Table Lookup.
• ARCUST.XLS—Customer History Lookup and Graphs.

Note

This appendix includes instructions for using Microsoft Query with 
Microsoft Excel. If necessary, install Microsoft Query from the Microsoft 
Office media. You may also need to create a shortcut to Query manually.

You can find additional information about using ODBC with Microsoft Excel on 
the Open Systems Web page on the Internet at http:\\www.osas.com.
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Building a Query For a Pivot Table

1. Start Microsoft Query.

2. From the File menu, select New. The Choose Data Source screen appears.

3. Select <New Data Source> and click OK. The Create New Data Source 
screen appears.

4. Enter a name you want to give the data source in box 1. You can use the 
same source again.

5. Select the BASIS ODBC Driver in box 2.
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6. Click Connect. The BASIS ODBC Driver Data Source Setup box appears.

7. Enter the file path and name of the CONFIG.TPM file you set up from within 
the OSAS ODBC software in the Database Configuration field, or click 
Browse to navigate to the file.

If you already built the shadow dictionary, click the Advanced button, and 
select the No Shadow Dictionary Consistency Check and Fast Connect 
check boxes to improve performance. See the online help for additional 
information about advanced options.

Note

If you are using OSASCS and you use the data server to access your data, 
enter your login name in the Network User ID field.

8. Click OK to connect to the data source. You are returned to the Create New 
Data Source screen.

9. Select a table in box 4 if you want to select a default table source; otherwise, 
leave the box blank and select any table when you develop the query.

If you select a table, the list of tables always starts at that table. Otherwise 
the list of tables starts at the beginning of the list.
ODBC Kit User’s Manual B-3



Microsoft Excel
10. When the Choose Data Source box appears, select the data source you set up 
in the previous steps.

11. When the Choose Columns screen appears, select a table you want to use in 
your Excel spreadsheet. For this example, start with one table and add a 
second table later. Select the SOTH table, select the columns for the 
spreadsheet, and click Next.
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12. The Filter Data dialog box appears. Use it to select specific records from the 
table. In most cases, you do not need to choose anything in this dialog box.

For example, to filter out credit memos, select the field named 
TRANSACTION_TYPE, select does not equal, and then enter 4 for a 
value. (TRANSACTION_TYPE 4 is a credit memo.)

13. Click Next. The Sort Order box appears.

Use it to select how the data is sorted in a query. For example, select a field 
in the Sort by field and check Ascending or Descending for the sort order. 
Select subsequent fields and sort orders for hierarchical sorts. For now, do 
not enter any sort fields. 
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14. Click Finish. You are returned to the Microsoft Query screen and the data in 
your query appears.

To delete a column, select a column and press the Delete key. You can also 
add a column by double-clicking on the field name in the SOTH box.

Note

You can also select which fields you want in your query in the Choose 
Columns screen as shown in step 11 on page B-4. Instead of selecting the 
entire table, you can click the + box next to the table you want and select the 
given fields from the list.

15. Select the following fields:

• BATCH_ID
• ORDER_NUMBER
• TRANSACTION_TYPE
• INVOICE_NUMBER
• INVOICE_DATE
• CUSTOMER_ID
• SUBTOTAL
• SALES_TAX
• TOTAL_COST
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16. From the Table menu, choose Add tables. The Add Table dialog box 
appears.

17. A list of all the tables appears. Select the SOTD table, and click Close.

Joining Fields

18. Locate BATCH_ID in the SOTD and SOTH tables. Click the BATCH_ID 
entry in the SOTH table and hold the left mouse button down.

19. Drag the field over to the BATCH_ID field in the SOTD table and release the 
mouse button. A line appears between the two BATCH_ID fields, joining the 
two fields.

20. Follow steps 18 through 19 with the ORDER_NUMBER field.

A message similar to the one shown below may appear. For now, click Yes 
to ignore the message and join the fields together.
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21. Select the following fields from the SOTD table:

• ENTRY_NUMBER
• UNIT_COST_COMPNT
• UNIT_PRICE
• ORDERED_QTY
• SHIPPED_QTY_SELL
• BACKORDERED_QTY.

22. To save the query, select Save from the File menu.

Using the Query in Microsoft Excel

1. Start Excel and open a new worksheet.

2. From the Data menu, select Pivot Table Report. The Pivot Table Wizard 
appears.

3. Step 1 of the wizard lists the options from which you can choose the data 
source to use in your Pivot Table. Select External Data Source and click 
Next.
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4. When step 2 of the wizard appears, click Get Data.

The Choose Data Source box from Microsoft Query appears. 

5. Click the Queries tab and select the query you saved in Microsoft Query.
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The Choose Columns dialog box under Query appears. 

6. Click Next. The query columns appear.

7. Click Next to pass by the Filter Data and Sort Order options. The Query 
Wizard - Finish dialog box appears.

8. Select Return Data to Microsoft Excel and click Finish. You are returned to 
the Pivot Table Wizard Step 2 of 4 dialog box.
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9. Click Next. The Pivot Table Wizard - Step 3 of 4 dialog box appears. 

The selected fields and four areas—Page, Row, Column, and Data—in 
which you can put fields appear. Drag and drop the fields to use in this report 
into the respective areas. (To view the full field name, hold the cursor on the 
button, and a tool tip appears listing the full field name.)

10. Drag and drop the following fields:

• TRANSACTION_TYPE into PAGE

• INVOICE_NUMBER, INVOICE_DATE, and ENTRY_NUM into ROW

• BATCH_ID into COLUMN 

• ORDERED_QTY, SHIPPED_QTY_SELL, UNIT_COST_COMPNT and 
UNIT_PRICE into DATA.
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The fields appear on the screen. Numeric fields dropped into the Data 
section become summary fields. 

11. Click Next. The Pivot Table Wizard - Step 4 of 4 dialog box appears. This 
final step lets you create the pivot table either in a new worksheet or in the 
existing worksheet. Accept the given options and click Finish. 
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The pivot table appears. 

Highlight rows and columns to shift them around. To view only invoices, change 
the Transaction Type value from All to 3. Change it to 4 and credit memos 
appear. Totals per type are also listed. 
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Adding a Calculated Field

You can also add new fields, like profit, to the data area. To add profit to the data 
area, follow these steps:

1. Highlight the last row in your data area, Sum of UNIT_PRICE, right-click, 
and select Insert from the menu that appears. The Insert Calculated Field 
dialog box appears.

2. Enter the following information about the inserted field:

• Enter Profit Dollars in the Name field.

• Enter the following (on one line) in the Formula field:

=(SHIPPED_QTY_SELL* UNIT_PRICE) - ( SHIPPED_QTY_SELL* 
UNIT_COST_COMPNT)

See the illustration above for an example of the completed calculated 
field.

3. Click Add, then click OK.
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The pivot table appears with the Sum of Profit Dollars field.

For more information about pivot tables, see the Microsoft Excel documentation 
or online help.
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For information about using Microsoft Query 97 and higher with the ODBC kit, 
see Appendixes B and D. If you require more information about Microsoft 
Query, consult the Microsoft Query User’s Guide or Online Help.

Before you use the ODBC Kit with Microsoft Query, complete these tasks:

• Install and set up the ODBC Kit.
• Install and set up the BASIS ODBC drivers.
• Install Microsoft Query.
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Microsoft Word

This appendix walks you through creating a dunning letter using the ODBC Kit, 
Microsoft Query 97 and higher, and Microsoft Word 97 and higher. If you require 
more information about Microsoft Word, consult the Microsoft Word User’s 
Guide or Online Help.

Please note that the appendix uses Microsoft Word 97 in the example 
illustrations. If you are using a more recent version of Word, the commands and 
interface may differ slightly.

Before you create this form letter, complete these tasks:

• Install and set up the ODBC Kit.
• Install and set up the BASIS ODBC drivers.
• Install Microsoft Query and Microsoft Word.

Note

This appendix includes instructions for using Microsoft Query with 
Microsoft Word. If necessary, you can install Microsoft Query from the 
Microsoft Office media. You may also need to create a shortcut to Query 
manually.

D
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Creating a Form Letter

To create a form letter, create a query for the form letter, and merge the letter and 
query, follow these steps:

1. Start Microsoft Word and select Mail Merge from the Tools menu. The Mail 
Merge Helper dialog box appears.

2. Select Create.

3. Select Form Letter from the Create options. A Microsoft Word message box 
appears.

4. Select Active Window. You are returned to the Mail Merge Helper dialog 
box. The Edit button appears. Use it to edit or enter text in the document.
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5. Select Get Data to connect to the OSAS data. If you have defined a query, 
select Open Data Source and select the query in the dialog box that appears. 
If you have not defined a query, select Create Data Source.  The Choose 
Data Source screen appears.

6. Select <New Data Source> and click OK. The Create New Data Source 
screen appears.

7. Enter a name you want to give the data source in box 1. You can use the 
same source again.

8. Select the BASIS ODBC Driver in box 2.
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9. Click Connect. The BASIS ODBC Driver Data Source Setup box appears.

10. Enter the file path and name of the CONFIG.TPM file you set up using the 
Edit CONFIG.TPM function in the Database Configuration field, or click 
Browse to navigate to the file.

If you have already built the shadow dictionary, click the Advanced button, 
and select the No Shadow Dictionary Consistency Check and Fast 
Connect check boxes to improve performance. See the online help for 
additional information about advanced options.

Note

If you are using OSASCS and you use the data server to access your data, 
enter your login name in the Network User ID field.

11. Click OK to connect to the data source. You are returned to the Create New 
Data Source screen.

12. Select a table in box 4 if you want to select a default table source. Otherwise, 
leave it blank and select any table when you develop the query. 

If you select a table, the list always starts at that table; otherwise the list 
starts at the first table.
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13. When the Choose Data Source box appears, select the data source you set up 
in the previous steps and click OK.

14. When the Choose Columns screen appears, select the tables you want to use 
in your Word form letter. For this example, select ARCU.

15. Select the following fields and click Next.

• CUSTOMER_ID
• CUSTOMER_NAME
• ADDRESS_LINE_1
• ADDRESS_LINE_2
• ADDRESS_LINE_3
• CITY
• STATE
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• ZIP_CODE
• ATTENTION
• BALANCE_31_60
• BALANCE_61_90
• BALANCE_91_120
• UNAPPLIED_CREDIT

16. The Filter Data box appears. Use the Filter Data dialog box to select specific 
records from the table. 

 Select the BALANCE_31_60 field, select is greater than, and select 0. This 
query will return only those customers whose BALANCE_31_60 field is 
greater than 0.

17. Click Next.
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18. When the Sort Order box appears, select ZIP_CODE in the Sort by field, and 
select Ascending as the sort order. Select CUSTOMER_NAME in the first 
Then by field, and select Ascending as the sort order..

The results of the query will sort first by the customer’s zip code and then by 
the customer’s name.

19. Click Next. The Query Wizard - Finish dialog box appears. Select View data 
or edit query in Microsoft Query, and click Finish
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You are returned to Microsoft Query.

20. Enter the following in the Criteria Field:

BALANCE_31_60+BALANCE_61_90+BALANCE_91_120+BALANCE_ 
OVER_120+UNAPPLIED_CREDIT

21. Select the entry in the Criteria Field and copy it to the clipboard (Ctrl+C).

22. Select Add Column from the Records menu. The Add Column dialog box 
appears.

23. Paste the contents you copied to the clipboard into the Field list box. Enter 
PAST_DUE in the Column heading text box. Click Add, then click Close.

You are returned to Microsoft Query. The PAST_DUE column is added to 
the query.

24. Select Save from the File menu to save the query.
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25. Select Return Data to Microsoft Word from the File menu. You are returned 
to Microsoft Word. If you have no merge fields defined in the document, a 
Microsoft Word message box appears.

26. Click Edit Main Document. The Mail Merge Helper dialog box closes and 
you are returned to the document.

27. Click the Insert Merge Field button to insert the fields (such as 
CUSTOMER_NAME) from the query into the form letter. Click the Insert 
Word Field button to insert Word fields (such as the current date) into the 
form letter. When you are finished with the letter, select Mail Merge from the 
Tools menu.
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28. When the Mail Merge Helper dialog box appears, click Merge to create the 
form letter.

29. When the Merge dialog box appears, select the merge options: New 
document, Printer, or Electronic mail. Click Check Errors if you want to 
proof the interaction between Microsoft Word and the query. Otherwise, 
click Merge to produce the letters.
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30. If you clicked Check Errors, the Checking and Reporting Errors dialog box 
appears.

31. Select the option you want to use during the merge and click OK.

32. You are returned to Microsoft Word.

Note

The form letter does not format decimal numbers that end in 0 correctly. For 
example, $49288.20 is produced as $49288.2.
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Sample Word Form Letter

 Builder’s Supply
 7626 Golden Triangle Drive
 Eden Prairie, MN 55344-3732

 {MERGEFIELD ATTENTION}
 {MERGEFIELD CUSTOMER NAME}
 {MERGEFIELD ADDRESS_LINE_1}
 {MERGEFIELD ADDRESS_LINE_2}
 {MERGEFIELD ADDRESS_LINE_3}
 {MERGEFIELD CITY}{MERGEFIELD STATE}{MERGEFIELD ZIP_CODE}
 {time\@ “D mmmm, yyyy”}

 Dear {MERGEFIELD ATTENTION},
 Our records indicate that a balance of ${MERGEFIELD PAST_DUE} is outstanding and past due on   
 your account. Please remit this amount immediately, or call our offices at (612) 555-0011 to   
 make other arrangements at your earliest convenience.
 If you have already sent payment, please accept our apologies for this letter.

 Sincerely,

 Carol Johnson
 Account Collection Dept.
 Builders’ Supply, Inc.
 
 CRJ/fsd
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This appendix walks you through creating a simple report using the ODBC Kit 
and Crystal Reports for Windows. If you require more information about Crystal 
Reports, consult the Crystal Reports User’s Guide or Online Help.

Before you create this report, complete these tasks:

• Install and set up the ODBC Kit.
• Install and set up the BASIS ODBC drivers.
• Install Seagate Crystal Reports for Windows.

The following Crystal Reports examples are included:

• ARLABEL.RPT—Customer Labels

• CRYSTAL.DOC—Instructions for setting up the customer list in Crystal 
Reports 

• ARCUST1.RPT— Customer List 

• ARCUST2.RPT—Customer List with Graph

•  BRRECON.RPT—Bank Reconciliation Reconciliation Report

You can find additional information about using ODBC with Crystal Reports on 
the Open Systems Web page on the Internet at http:\\www.osas.com.

E
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Crystal Reports Customer List

To create a customer list using Crystal Reports for Windows, follow these steps:

1. Start Crystal Reports and select New from the File menu. The Report Gallery 
screen appears.

2. Click the Standard report format. The Create Report Expert screen appears.
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3. Select SQL/ODBC as your source on the Data tab. The Log On Server 
dialog box appears. 

4. Select the data source you set up for OSAS ODBC data under the Windows 
ODBC Administrator. The Choose SQL Table dialog box appears.

5. Select the ARCU file, click Add, and then click Done. You are returned to 
the Create Report Expert screen.
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6. Click the Fields tab or click Next. The Fields tab appears.

7. Select the following fields for the report:

• CUSTOMER_ID
• CUSTOMER_NAME
• ADDRESS_LINE_1
• ADDRESS_LINE_2
• ADDRESS_LINE_3
• CITY
• STATE
• COUNTRY_CODE
• ATTENTION
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8. Click the Sort tab or click Next. The Sort tab appears.

9. Select CUSTOMER_ID to sort the report by.

10. Click the Style tab. The Style tab appears.

11. Enter Customer Detail List for the title.
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12. Select Standard for the report style. 

13. Select Preview Report. The report appears.

The example report included with the OSAS ODBC package resembles the AR 
Customer Detail List. You can move the fields by dragging and dropping them. 
(Column titles on the sample report have been deleted.)

To insert text fields on the report, follow these steps:

1. Select Text Object from the Insert menu to add text fields. 

2. Move the cursor to where you want to add text to the report.

3. Type in the text.
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Common Questions

These are commonly asked questions about the ODBC Kit.

It takes a long time to build the shadow dictionary, and it does it every time I 
connect to the ODBC Driver.

If you do not select the Fast Connect and No Shadow Dictionary Consistency 
Check check box options in the Advanced Settings on the ODBC data source, 
the shadow dictionary will be rebuilt every time you start an ODBC connection. 
Changing these option settings will speed up data connections and prevent the 
ODBC driver from rebuilding the shadow dictionaries when you start the driver.

I get a message that the user count is exceeded.

Wait a few seconds for memory to cache out the last activation of the ODBC 
Driver. The message usually appears if you try to access a second data source 
soon after you finished using the same connection with a different source.

What is DDBUILDER?

DDBUILDER is the BASIS tool used to create the data dictionary. You can use 
the DDBUILDER or the OSAS functions on the Dictionary Tools menu to create 
the data dictionaries needed to work with ODBC.
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Registration and Delivery

If your computer cannot be connected to the Internet, BASIS supplies you with 
other methods of receiving the license registration information. In step 15 of the 
installation process (see page 2-11), you are presented with several alternative 
choices. Follow the instructions below to register your license using one of these 
alternatives: 

E-mail page G-2

Telephone page G-5

Fax page G-11

Other page G-18

G
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E-mail

Note

To receive the license information via e-mail, you first need an e-mail 
account. 

1. In the Registration Method box, select the Email To option.

2. Select the Email Address option and enter the e-mail address at which you 
want to receive the license file information.

3. Click Next.
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4. The License Information Confirmation screen appears. Confirm the 
information listed and, if it is correct, click OK. If there is an error, click 
Cancel and reenter the information. 

5. The Success box appears when the e-mail has been sent to BASIS. Click OK 
to continue.

6. If you want to install another license, click Yes. The License and 
Registration box (see step one) appears. If not, click No and the Registration 
Notification screen (see step seven) appears.
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7. Follow the instructions on the screen and click Next. 

8. If you have not installed the license, click Next. The installation process 
begins with the Install A BASIS License screen shown on page 2-13. If you 
do not want to install the license, click Cancel and the Attention screen 
(below) appears and the installation process ends.
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Telephone

1. In the Registration Method box, select the Telephone option.

2. Select the Fax Number option and enter the fax number at which you want 
to receive the license file information. In the Country list box, select the 
appropriate country and click Next.
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3. The Telephone License Request screen appears. Confirm the information 
listed, and if it is correct, click OK. If the information is incorrect, click 
Cancel and reenter the information. 

4. When the Print dialog box appears, select the printer to use and click OK to 
print the information you need to give to BASIS for your license. 

Below is an example of the document that prints:
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Registration and Delivery
5. To complete the installation of your driver, call the phone number on the 
printout. Follow the voice recording’s instructions to specify the information 
on the printout, and follow the instructions to register your license. 

Once you receive the information, follow these instruction:

1. On your Windows desktop, click Start, point to Programs, then to BASIS 
ODBC Driver 3.01, and then click Install a BASIS License. The Install A 
BASIS License screen appears. Click Next. 
ODBC Kit User’s Manual G-7



Registration and Delivery
2. Select the Enter License Information option and enter the information 
received from BASIS into the appropriate fields. Click Next.

3. If you use OSASCS for Windows or UNIX/Linux, enter the name of the 
server that is running the Data Server. If you are using standard OSAS or 
OSASCS for Novell, leave the field blank. In either case, click Next.
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Registration and Delivery
4. Click Finish.

5. If you do not want to view the readme.txt file, clear the check box. 
Otherwise, click Finish. 
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Registration and Delivery
6. The Setup Complete screen appears. If you do not want to restart your 
computer, select the No option. If you do want to restart your computer now, 
first be certain that all other programs are closed. Then click Finish to 
activate your ODBC driver. 

7. Before you use the ODBC driver you must:

• Install the ODBC Kit from your OSAS media.

• Create the config.tmp file (see page 3-3).

8. Once you complete these two steps, you can follow the Installing ODBC 
Drivers instructions page 2-19.
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Registration and Delivery
Fax

1. In the Registration Methods box, select the Fax option. 

2. Select the Fax Number option and enter the fax number at which you want 
to receive the license file information. In the Country list box, select the 
appropriate country and click Next.
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Registration and Delivery
3. The License Information Confirmation screen appears. Confirm the 
information listed, and if it is correct, click OK. If the information is 
incorrect, click Cancel and reenter the information. 

4. In the Emergency Contact Information screen, enter a contact name and 
phone number in case your fax cannot be sent. Click OK.
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Registration and Delivery
5. The Print screen appears (below is an example). Click OK to print the 
information you need to fax to BASIS for your license. 

6. To complete the installation of your driver, call the phone number on the 
printout. Follow the instructions on the voice recording to specify the 
information on the printout and to register your license.
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Registration and Delivery
Once you receive the information, follow these instruction:

1. On your Windows desktop, click Start, point to Programs, then to BASIS 
ODBC Driver 3.01, then select Install a BASIS License.

2. The Install A BASIS License screen appears. Click Next. 
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Registration and Delivery
3. Select the Enter License Information option. Enter the information received 
from BASIS into the appropriate fields and click Next.

4. If you use OSASCS for Windows or UNIX/Linux, enter the name of the 
server that is running the Data Server. If you are using standard OSAS or 
OSASCS for Novell, leave the field blank. In either case, click Next.
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Registration and Delivery
5. Click Finish.

6. If you do not want to view the readme.txt file clear the check box. 
Otherwise, click Finish. 
ODBC Kit User’s ManualG-16



Registration and Delivery
7. The Setup Complete screen appears. If you do not want to restart your 
computer, select the No option. If you do want to restart your computer now, 
first be certain that all other programs are closed. Click Finish to activate 
your ODBC driver. 

8. Before you use the ODBC driver you must:

• Install the ODBC Kit from your OSAS media.

• Create the config.tmp file (see page 3-3).

9. Once you have completed these two steps, you can follow the Installing 
ODBC Drivers instructions page 2-19.
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Registration and Delivery
Other

The Other option is useful for installing your license if the computer on which 
you installing does not have E-mail or Internet access. 

1. In the Registration Method box, select the Other option. 

2. Select either the Email Address or Fax Number option (depending on how 
you want to receive the license) and enter the e-mail address or fax number 
at which you want to receive the license file information. If you entered a fax 
number, select the appropriate country in the Country list box. Click Next to 
continue.
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Registration and Delivery
3. Read the WARNING! screen’s instructions carefully. Click OK to proceed.

4. The License Information Confirmation screen appears. Confirm the 
information listed, and if it is correct, click OK. If it is not correct, click 
Cancel and reenter the information. 
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Registration and Delivery
5. The Save As screen appears. Save the license file onto a diskette (or on a 
network drive). Click Save.

6. Access the file on the diskette or the network drive from a computer with e-
mail access.

7. Send the file to BASIS via e-mail.

8. An e-mail message or fax is sent to you from BASIS. Follow the instructions 
to register the license information on the original computer. 
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Registration and Delivery
Once you receive the information, follow these instructions:

1. On your Windows desktop, click Start, point to Programs, then to BASIS 
ODBC Driver 3.0, then select Install a BASIS License. The Install A BASIS 
License screen appears. Click Next. 
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Registration and Delivery
2. Select the Enter License Information option and enter the information 
received from BASIS into the appropriate fields. Click Next.

3. If you use OSASCS for Windows or UNIX/Linux, enter the name of the 
server that is running the Data Server. If you are using standard OSAS or 
OSASCS for Novell, leave the field blank. In either case, click Next.
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Registration and Delivery
4. Click Finish.

5. If you do not want to view the readme.txt file, clear the check box. 
Otherwise, click Finish. 
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Registration and Delivery
6. The Setup Complete screen appears. If you do not want to restart your 
computer, select the No option. If you do want to restart your computer now, 
first be certain that all other programs are closed. Click Finish to activate 
your ODBC driver. 

7. Before you use the ODBC driver you must:

• Install the ODBC Kit from your OSAS media.

• Create the config.tmp file (see page 3-3).

8. Once you have completed these two steps, follow the Installing ODBC 
Drivers instructions page 2-19.
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Index
Numerics
32-BIT ODBC drivers

installing, 2-5

A
Abandon

function key, 1-34
pull-down menu command, 1-34
verification button, 1-41

About OSAS
pull-down menu command, 1-36

Access Code
tool button, 1-20

access code
entering in graphical menus, 1-20

Access Codes
parameter, 1-4

accessing data
Crystal Reports, E-1
Microsoft Access, A-1
Microsoft Excel, B-1
Microsoft Query, C-1
Microsoft Word, D-1

Add/Change Reserved Words
function, 4-21

adding
comments, 1-54

Alias Inventory Lookup
function key, 1-39, 1-46
pull-down menu command, 1-39

Application Information
tool button, 1-23

Application Setup
right-click menu, 1-25

Audit Field Names For Reserved Words

function, 5-7

B
base applications

defined, 1-3
BASIS ODBC drivers

installing on Windows 95, 2-5
installing on Windows NT, 2-5

Bell mode
pull-down menu command, 1-36

C
Calculator

tool button, 1-21, 1-40
change to/from Favorites

tool button, 1-21, 1-25
changing companies

graphical menus, 1-25
click

defined, 1-9
Command Help

pull-down menu command, 1-36
commands

in-field editing, 1-47
report, 1-62
scroll region, 1-47

comments
adding, 1-54
editing, 1-54
viewing, 1-52

companies
changing, 1-25

company parameter, 1-4
conventions

report, 1-57
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user’s manual, 1-9
Copy

function key, 1-35, 1-48
pull-down menu command, 1-35
tool button, 1-40

Copy File(s) To Dictionary
function, 4-5

Crystal Reports
and ODBC Kit, 1-7

Crystal Reports for Windows, E-1
Ctrl-J function key, 1-35
Ctrl-Z function key, 1-35
cursor

moving down or forward one field, 1-34
moving up or back one field, 1-34
selecting item, 1-45

Cursor end
function key, 1-48

Cursor home
function key, 1-48

Cursor left
function key, 1-47

Cursor right
function key, 1-47

Customer/Vendor Inventory Lookup
function key, 1-39, 1-46
pull-down menu command, 1-39

D
DDBUILDER, F-1
Del function key, 1-47
Delete

function key, 1-34
pull-down menu command, 1-34
tool button, 1-40

delete
information on a screen, 1-34
line item, 1-38, 1-47

Delete character
function key, 1-47

Delete Line command
function key, 1-38, 1-47
pull-down menu command, 1-38

Delete to End of Line
function key, 1-48
I-2
Description Inventory Lookup
function key, 1-39, 1-46
pull-down menu command, 1-39

deselect
defined, 1-10

Detail Inventory Lookup
function key, 1-39

Dictionary Field List
function, 5-5

Dictionary Reports
menu structure, 1-7

Dictionary Tools
menu structure, 1-7

Documents, 1-55
File Types, 1-55
opening, 1-56
viewing, 1-56

double-click
defined, 1-9

Down Arrow
inquiry command, 1-45
report command, 1-62
scroll region command, 1-38, 1-47

E
Edit CONFIG.TPM

function, 3-3
edit line item, 1-47
editing

comments, 1-54
EIS

defined, 1-3
End

inquiry command, 1-45
report command, 1-62
scroll region command, 1-38, 1-47

End function key, 1-48
Enter

inquiry command, 1-45
scroll region command, 1-47

Esc
inquiry command, 1-45

Executive Information Summary
defined, 1-3

Exit
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function key, 1-35
pull-down menu command, 1-35

exit
from inquiry window, 1-45
from report to menu, 1-62
from screen or window, 1-35

F
F1 function key, 1-37
F10 function key, 1-48
F2 function key, 1-34
F3

function key, 1-40
scroll region command, 1-38, 1-47

F3 function key, 1-34
F5 function key, 1-34
F6

function key, 1-40
F6 function key, 1-34
F7

inquiry command, 1-45
report command, 1-62

F7 function key, 1-35
F9 function key, 1-48
Fast Connect

Microsoft Access, A-6
Microsoft Query, B-3, D-4

Favorites Menu, 1-49
adding items to, 1-25
changing to/from, 1-25

Favorites Menus
removing items from, 1-25

Field Down
function key, 1-34
pull-down menu command, 1-34

Field Up
function key, 1-34
pull-down menu command, 1-34

Fields
function, 4-13

Files
function, 4-7

First Line command
function key, 1-38, 1-47
pull-down menu command, 1-38
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Function help, 1-25
function keys

Ctrl-J, 1-35
Ctrl-Z, 1-35
Del, 1-47
Down Arrow, 1-34
End, 1-48
F1, 1-37
F10, 1-35, 1-48
F2, 1-34, 1-41
F3, 1-34
F5, 1-34
F6, 1-34
F7, 1-35
F9, 1-48
Home, 1-48
Ins, 1-48
Left, 1-47
PgDn, 1-34
PgUp, 1-34
Right, 1-47
Shift+F3, 1-46
Shift+F4, 1-46
Shift+F5, 1-46
Shift+F6, 1-46
Shift+F7, 1-46
Shift+F8, 1-46
Shift-F1, 1-37
Shift-F10, 1-48
Shift-F3, 1-39
Shift-F4, 1-39
Shift-F5, 1-39
Shift-F6, 1-39
Shift-F7, 1-39
Shift-F8, 1-39
Shift-F9, 1-35, 1-48
Up Arrow, 1-34

G
Global Inquiry

defined, 1-3
graphical menu

exiting from, 1-18
features of, 1-17
right-click menu, 1-24, 1-41
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sample screen, 1-18
graphical menus

right-click menu, 1-24, 1-41
GUI/Text Using OSAS with Contractors’ Job Cost, 1-17

H
Help, 1-25

function key, 1-37
pull-down menu command, 1-37
tool button, 1-23, 1-40

help commands
F3, 1-43
F6, 1-43
F7, 1-43

History command, 1-54
Home

inquiry command, 1-45
report command, 1-62
scroll region command, 1-38, 1-47

Home function key, 1-48

I
Indexes

function, 4-17
Information command, 1-51
Information menu, 1-51

Comments command, 1-52
Documents command, 1-55
History command, 1-54
Information command, 1-51

Inquiry
function key, 1-34, 1-41
graphical, 1-41
partial-key, 1-44
pull-down menu command, 1-34

inquiry commands
Down Arrow, 1-45
End, 1-45
Enter, 1-45
Esc, 1-45
F7, 1-45
Home, 1-45
Ins, 1-45
PgDn, 1-45
PgUp, 1-45
I-4
Up Arrow, 1-45
Ins

inquiry command, 1-45
scroll region command, 1-38, 1-47

Ins function key, 1-48
Insert Line command

function key, 1-38, 1-47
pull-down menu command, 1-38

Insert line item, 1-38, 1-47
Insert mode

function key, 1-48
Inventory Lookup

commands, 1-39, 1-46
Inventory Lookup commands, 1-39

alias lookup, 1-39
customer/vendor lookup, 1-39
description lookup, 1-39
detail lookup, 1-39
lot lookup, 1-39
serial lookup, 1-39
Shift-F3, 1-39
Shift-F4, 1-39
Shift-F5, 1-39
Shift-F6, 1-39
Shift-F7, 1-39
Shift-F8, 1-39

Inventory lookup commands
Alias Lookup, 1-46
alias lookup, 1-46
Customer/Vendor Lookup, 1-46
Description Lookup, 1-46
Detail Lookup, 1-46
Lot Lookup, 1-46
Serial Lookup, 1-46

inventory search commands, 1-46
Shift + F6, 1-46

J
Jump

function key, 1-35
pull-down menu command, 1-35

Jump command
function key, 1-38
pull-down menu command, 1-38
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L
Last Line command

function key, 1-38, 1-47
pull-down menu command, 1-38

Left Arrow
report command, 1-62

Left Arrow function key, 1-47
Lists

printing, 5-4
live data

changing to, 1-20, 1-25
Lot Inventory Lookup

function key, 1-39, 1-46
pull-down menu command, 1-39

M
Maintenance

function key, 1-34
pull-down menu command, 1-34
tool button, 1-40

manual
conventions, 1-9

Master Lists
printing, 5-4

Menu styles, 1-10
menus

information menu, 1-51
structure in AR, 1-7

Microsoft Access, A-1
and ODBC Kit, 1-7

Microsoft Excel, B-1
and ODBC Kit, 1-7

Microsoft Query, C-1
and ODBC Kit, 1-7

Microsoft Word, D-1
and ODBC Kit, 1-7

mouse commands
click, 1-9
deselect, 1-10
double-click, 1-9
right-click, 1-9

MS-DOS prompt
tool button, 1-24
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N
Next Line command

function key, 1-38, 1-47
pull-down menu command, 1-38

Next Page command
function key, 1-38, 1-47
pull-down menu command, 1-38

No Shadow Dictionary Consistency Check
Microsoft Access, A-6
Microsoft Query, B-3, D-4

O
ODBC

and SQL, 1-7
ODBC Administrator, 2-3
ODBC driver setup

installation, 2-19
ODBC drivers

installing on Windows 95, 2-5
installing on Windows NT, 2-5

ODBC Kit
description, 1-7
installation checklist, 2-3
interaction, 1-7
menu structure, 1-7

OK (Proceed)
function key, 1-34
pull-down menu command, 1-34

Online Documentation
function key, 1-37
pull-down menu command, 1-37
tool button, 1-40

opening
documents, 1-56

Options
table, 4-23

OPTxxx table, 4-23
OSAS

running, 1-4
system requirements, 1-4

output device
printer, 1-59

P
parameters
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access code, 1-4
command to start OSAS, 1-4
company ID, 1-4
general expression, 1-4
terminal ID, 1-4

partial-key inquiry, 1-44
Paste

function key, 1-35, 1-48
pull-down menu command, 1-35
tool button, 1-40

PgDn
inquiry command, 1-45
report command, 1-62
scroll region command, 1-38, 1-47

PgDn function key, 1-34
PgUp

function key, 1-40
inquiry command, 1-45
report command, 1-62
scroll region command, 1-38, 1-47

PgUp function key, 1-34
Pop-Up Calendar

tool button, 1-40
Previous Line command

function key, 1-38, 1-47
pull-down menu command, 1-38

Previous Page command
function key, 1-38, 1-47
pull-down menu command, 1-38

Print Manager
defined, 1-3

PRO/5 Command
tool button, 1-24

Proceed (OK)
function key, 1-34
pull-down menu command, 1-34
verification button, 1-41

Proceed command, 1-13
pull-down menu

functions
commands, 1-34
Edit, 1-35
Help, 1-36
Information, 1-37
Inventory Lookup, 1-39
Modes, 1-35
I-6
Other, 1-36
Scroll Commands, 1-38

graphical menus, 1-20
Favorites, 1-21
File, 1-20
Help, 1-23
Modes, 1-21
Other, 1-22
Tools, 1-21

pull-down menus
functions

information menu, 1-51

Q
Quick mode

pull-down menu command, 1-36

R
report commands, 1-62

Down Arrow, 1-62
End, 1-62
Exit, 1-62
F7, 1-62
Home, 1-62
PgDn, 1-62
PgUp, 1-62
Right Arrow, 1-62
Tab, 1-62
Up Arrow, 1-62

Reports
conventions, 1-57
including all information, 1-57
limiting information, 1-57
selecting information for, 1-57

Reserved Words List
function, 5-9

Resource Manager
features of, 1-3

Right Arrow
report command, 1-62

Right Arrow function key, 1-47
right-click

defined, 1-9
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S
sample data

changing to, 1-20, 1-25
scroll region commands, 1-47

Down Arrow, 1-38, 1-47
End, 1-38, 1-47
Enter, 1-47
F3, 1-38, 1-47
Home, 1-38, 1-47
Ins, 1-38, 1-47
PgDn, 1-38, 1-47
PgUp, 1-38, 1-47
Tab, 1-38
Up Arrow, 1-38, 1-47

Serial Inventory Lookup
function key, 1-46
pull-down menu command, 1-39

Set up application, 1-25
Shift+F2 menu, 1-51

Comments command, 1-52
Documents command, 1-55
History command, 1-54
Information command, 1-51

Shift-F1 function key, 1-37
Shift-F10 function key, 1-35, 1-48
Shift-F3 function key, 1-46
Shift-F4 function key, 1-46
Shift-F5 function key, 1-46
Shift-F6 function key, 1-39, 1-46
Shift-F7 function key, 1-39, 1-46
Shift-F8 function key, 1-39, 1-46
Shift-F9 function key, 1-35, 1-48
SQL, 1-7
Start Over

function key, 1-34
pull-down menu command, 1-34
tool button, 1-40

Start-style menu
exiting from, 1-19
features of, 1-17
right-click menu, 1-24, 1-41
sample screen, 1-19

T
Tab
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report command, 1-62
scroll region command, 1-38

Tables
function, 4-23
use of, 4-23

terminal
parameter, 1-4

toggle
between halves of reports, 1-62

tool button
Access Code, 1-20
Application Information, 1-23
Calculator, 1-21, 1-40
change to/from Favorites, 1-21
Copy, 1-40
Delete, 1-40
Help, 1-23, 1-40
Maintenance, 1-40
MS-DOS prompt, 1-24
Online Documentation, 1-40
Paste, 1-40
Pop-Up Calendar, 1-40
PRO/5 Command, 1-24
Start Over, 1-40
Workstation Date, 1-20

toolbar
function screen toolbar, 1-40
graphical menus, 1-23

U
Undo

function key, 1-35, 1-48
pull-down menu command, 1-35

Up Arrow
inquiry command, 1-45
report command, 1-62
scroll region command, 1-38, 1-47

user’s manual
conventions, 1-9

V
verification button

Abandon, 1-41
Proceed (OK), 1-41

Verify-exit mode
I-7



pull-down menu command, 1-35
Verify-PgDn mode

pull-down menu command, 1-36
view

definition, 4-7
View inquiry command, 1-45
viewing

comments, 1-52
documents, 1-56

W
Workstation date

tool button, 1-20
workstation date

entering in graphical menus, 1-20
I-8
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